Scripting and Programming for Modeling, Simulation, and Control

Copyright © Bruce Char
2008-10
Scripting and Programming for Modeling, Simulation, and Control

All rights reserved. Permission is given to Staff and students of CS 121, Fall 2010 to reproduce these notes for their personal use only.
Contents

1 Introduction -- Technical computing at the turn of the century .......................................................... vii
  1.1 Chapter synopsis ................................................................. 1
  1.2 What is technical computing? What kinds of technical computing are there? ............................... 1
  1.3 What are the advantages of doing technical calculation with a computer? ...................................... 1
  1.4 The spectrum of devices for technical computing  ................................................................................. 2
    Personal computers ................................................................................................................................. 2
    High performance computers, also known as "supercomputers" .......................................................... 3
    Hand held or mobile devices .................................................................................................................... 3
    Dedicated controllers ............................................................................................................................... 4
  1.5 Maple, a system for technical computing ........................................................................................... 5
  1.6 What about Systems X, Y, Z, ...? ........................................................................................................ 5
  1.7 Why pick Maple as the first system? .................................................................................................... 5
  1.8 Using more than one system ................................................................................................................. 6

2 Getting started with Maple's Document Mode: doing technical work with a clickable interface .................. 9
  2.1 Chapter synopsis ...................................................................................................................................... 9
  2.2 Starting up Maple, getting a fresh start ............................................................................................... 9
  2.3 Evaluating an expression involving exact arithmetic ....................................................................... 11
    Grade school arithmetic .......................................................................................................................... 11
    Making typographical mistakes .......................................................................................................... 16
    Correcting typographical mistakes ...................................................................................................... 19
    Exponentiation (powers). Numbers with lots of digits ......................................................................... 20
    Detecting and fixing vocabulary and "logic" mistakes ........................................................................... 21
  2.4 Saving and retrieving your work .......................................................................................................... 22
  2.5 Retrieving backups .............................................................................................................................. 23
  2.6 Algebra, plotting and mouse-clickable operations .............................................................................. 24
    Algebraic expressions and equations. Solving equations. Working with pieces of expressions ............... 24
    For those with previous experience on other systems: some things are different, for a reason ............. 25
    Plotting and approximate numerical solutions .................................................................................... 26
    The Expressions Palette and the Common Symbols Palette: entering Trigs, logs, roots, exponentials .... 28
    Approximate numerical (calculator - type) arithmetic in Maple ......................................................... 29
    Evaluation, and selection of pieces ........................................................................................................ 30
  2.7 A quick-reference summary to this chapter ....................................................................................... 31

3 Chapter 3 Technical word processing ..................................................................................................... 37
  3.1 Chapter Overview .................................................................................................................................. 37
  3.2 Maple as a word processor .................................................................................................................. 37
  3.3 Shortcuts to entering math symbols .................................................................................................... 40
  3.4 Other word processor features ........................................................................................................... 40
  3.5 Troubleshooting word processing ....................................................................................................... 41
  3.6 Summary of Chapter 3 material .......................................................................................................... 41

4 Chapter 4 Assignment .............................................................................................................................. 43
  4.1 Chapter Overview .................................................................................................................................. 43
  4.2 Assignment: remembering results for future use ............................................................................. 43
  4.3 Assignment keyboard shortcut := .................................................................................................... 44
  4.4 How to think about assignment: a mental model .............................................................................. 46
  4.5 The state of the Maple session and the look of the worksheet ............................................................ 48
  4.6 restart causes all assignments to be forgotten .................................................................................... 49
  4.7 Evaluation and assignment .................................................................................................................. 49
  4.8 Troubleshooting assignments ............................................................................................................ 51
  4.9 Summary of Chapter 4 material .......................................................................................................... 55

5 Chapter 5 Building scripts ........................................................................................................................ 57
List of Tables

Table 1.1: An early computer ................................................................. 2
Table 1.2: A high-end calculator in 2009 ................................................ 4
Table 2.1: Maple started up with new document in Windows XP .................. 9
Table 2.2: Maple document with first entry area ....................................... 10
Table 2.3: Maple input using 2d math ...................................................... 11
Table 2.4: Maple input with labeled result ............................................... 11
Table 2.5: Arithmetic Operations in Maple .............................................. 12
Table 2.6: Examples of Maple error messages ........................................... 16
Table 2.7: Create Document Block to force a Math input area wherever the cursor is placed ................................................................. 20
Table 2.8: Example of a vocabulary mistake .............................................. 21
Table 2.9: Maple save menu operation ..................................................... 22
Table 2.10: Maple save dialog box .......................................................... 23
Table 2.11: The Maple state display ........................................................ 23
Table 2.12: Example of Plotting ............................................................... 26
Table 2.13: Plot created by right-click -> Plot -> 2DPlot ............................ 27
Table 2.14: User-configured plot using PlotBuilder instead of 2DPlot ............. 27
Table 2.15: The Expression palette .......................................................... 28
Table 2.16: Examples of palette-driven computation ...................................... 29
Table 2.17: Examples of computing with approximate solving ........................ 29
Table 2.18: Evaluate at a point ............................................................... 30
Table 2.19: Operations on equations, multi-part expressions .......................... 30
Table 3.1: Maple in math entry mode ....................................................... 37
Table 3.2: Document after control-T (or Insert->Text) ................................. 38
Table 3.3: Document with a mixture of text and math .................................. 39
Table 3.4: control−= puts the results of a calculation in the midst of text .......... 39
Table 3.5: Keyboard shortcuts in math mode through the escape key ............... 40
Table 4.1: Assignment ......................................................................... 43
Table 4.2: Assignment ......................................................................... 44
Table 4.3: Mental model of assignment ..................................................... 46
Table 4.4: Example: The state of a Maple Session ....................................... 48
Table 4.5: Evaluation of expressions involving assigned variables .................. 49
Table 4.6: Evaluation of expressions involving assigned variables .................. 49
Table 4.7: Reassignment undoes the effect of previous assignment ................ 53
Table 4.8: Maple won't let you use some names it is already using ................ 54
Table 5.1: Basic data structures in Maple and operations to extract parts of them ........ 57
Table 5.2: Solving simultaneous equations ............................................... 59
Table 6.1: Absolute error and relative error Commentary ................................ 82
Table 6.2: Guidelines for using exact and limited-precision numbers in Maple ........................................................... 85
To our students, who learn how to work with the new and different.

To my family, whose support is unwavering.

**Acknowledgements**

Jeremy Johnson started the Computation Lab course. He chose the initial direction and approach of the course. Frederick W. Chapman worked with us in 2006-2008 in the development of the course.

We are grateful to our colleagues David Augenblick, Jeremy Johnson, and Brian Dolhansky for their help in the development of this text. David was a careful proofreader and useful sounding board. Jeremy's shrewd counsel and feedback often led to improvements. Brian's expert and speedy work in tagging and repairing the manuscript kept us on schedule. We also appreciate the assistance of Maplesoft for technical advice and support, especially that of Christina Spirou.
1 Introduction -- Technical computing at the turn of the century

1.1 Chapter synopsis

1. We explain what technical computing is about, why it's done with a machine and what kinds of devices are used to do it.

2. The advantages doing calculation with a computer are surveyed.

3. Maple, a system for technical computing is introduced and contrasted with some of the other choices available today.

1.2 What is technical computing? What kinds of technical computing are there?

Well, obviously, it's "computing done for technical work" -- primarily science and engineering, but any other field where mathematical and scientific reasoning is used, which nowadays can include other fields such as finance and business, medicine, or digital media. The success of such reasoning in these fields is well-known. Students of those fields need to become experienced and develop proficiency in how it's done to be able to obtain success in the same way.

You are probably familiar with numerical computing since it's done even without computers, with paper and pencil or with calculators in high school or even earlier. You probably have also seen graphing calculators do simple kinds of graphical computing, also sometimes known as mathematical visualization. In addition to this, computers can and are used to do symbolic computing -- computing where the answer is a formula rather than a number, as well as deductive or logical computing -- using logic or deduction to find answers.

In this course, we will concentrate on numerical, symbolic and graphical computing, although we will see some instances of deductive computing as well.

1.3 What are the advantages of doing technical calculation with a computer?

One advantage is greater quantity of calculation-- computers can do calculations billions of times faster than humans and thousands or millions of times faster than calculator-driven computation.. Using them makes some things feasible that are not possible any other way:

As you've seen with your high school physics, chemistry, and math courses, scientists and engineers often work with mathematical models -- systems of equations, symbols, and mathematical relations that try to describe key aspects of a situation. Calculation with models helps answer questions about the situation being modeled: How much fuel will be used in this operating scenario? How long will it take to heat up the furnace to 265 degrees? Computer simulation loads a model with some initial conditions, and then through calculation produces predictive results. Simulation can be used to make forecasts such as: how fast will the vehicle be moving after 5 seconds? How far will the pollutants move underground after being buried five years? Computer simulations can sometimes generate predictions even when standard techniques of "mathematical solution" are not adequate to find an answer.

Computers make it possible to use models that require much more extensive calculations to reach conclusions. The payoff may be better predictions. Extensive calculation also makes it possible to generate and present more information. Computer visualization goes beyond that to highly detailed pictures or animations of a situation described through a mathematical model. This can lead to better insight and understanding.

Another advantage is that it is easier to make a lasting written record of the work. One of the big differences between professional technical work and homework is that the modeling and calculation has lasting value: it matters to more than one or two people, and it is being used in an on-going project. In a professional situation, a worker may need to go back and review the work a year later, long after the details are faded from easy recall. Other people may want to reuse the programming and will need to be given an explanation about how to use it. Since they have long-term value, it is beneficial to put them into a form suitable for easy future reference and reuse. Thus the work typically includes both programming and documentary explanation.
1.4 The spectrum of devices for technical computing

Back in the days of the original electronic computers developed during and immediately after World War II, the only kind of device you could use for technical computing (which was the only computing that could be justified in those days) filled up a whole room and needed an extensive staff to support.

Table 1.1: An early computer

<table>
<thead>
<tr>
<th><img src="https://www.seas.upenn.edu/~museum/" alt="ENIAC" /></th>
</tr>
</thead>
</table>

ENIAC, one of the first electronic computers, being programmed by Herman Goldstine at the University of Pennsylvania circa 1946. (US Army photo) Originally intended to do artillery calculations, it was used for the design and development of the first thermonuclear weapons.

See http://www.seas.upenn.edu/~museum/.

Today's users have a choice of a wide variety of devices:

**Personal computers**

Typically a computer for individual use can be expected to have the following features:

1. Processing capability of a billion or more arithmetic or memory operations per second. Significant amounts of calculation are used in doing the graphics involved in processing digital media or supporting the artificial worlds presented in computer games. This same power can be used to do the simulation and exploration in many common kinds of scientific and engineering situations. This course is about using that calculation power.

2. Standard selection and pointing devices, keyboard and mice. Some computers support "tablet" operation which allow use of a pen writing on the display. The display area and input devices make it easy to enter information via text or by pointing/selection. While the World Wide Web has made much processing possible with just "pointing and clicking", the complexity and mathematical sophistication of the models used in current technical computing outstrip the capabilities of current "point and click" technology. Some (computer programming) language-based interaction is necessary to handle things deftly. This requires a more knowledgeable user, but many people find that the extra power is worth the learning effort.

3. A screen capable of displaying information equivalent to one or more 8 1/2 x 11 inch pieces of paper. This helps support the development of documentation, or of more complex visualizations.

4. Local storage capable of storing a significant fraction of the text of the books in the Library of Congress. Of course, it's easy for a personal media collection to fill up this kind of storage, but it should not be forgotten that the billions of characters that this storage represents can store years or decades of efforts of computer programmers.

5. Connection to the internet, which makes it easier to communicate and share work with others, and to download new programming. From the viewpoint of technical computing, that it's easy to import and run substantial amounts of programming.
High performance computers, also known as "supercomputers"

While hand held devices and personal computers are used widely by the general public for non-technical purposes, there are a class of computers that are used primarily for mathematically-based computing. Typically instead of billions of numerical operations per second ("gigaflops" -- billions of floating point operations), they employ multiple processors in parallel to do trillions of operations ("teraflops") or quadrillions ("petaflops"). The hardware, personnel and energy costs of such computers are significant, so typically they are available through centers used through the Internet from many locations. The kinds of technical problems such devices are used for would include: simulation of complicated physical situations, such as for climate prediction, astrophysics, or engineering design (aircraft, groundwater, large building, automobile).

Using such large devices incur significant expense, from hardware, software and support staff costs, as well as electrical power consumed. For example, the U.S. Department of Energy has an IBM computer at its Los Alamos National Laboratory in New Mexico, USA capable of 1 quadrillion (10^15) numerical operations per second. It consumes 2345.50 kilowatts when it is running. (reference: http://blog.enterpriseflows.com/green/blog/2008/06/green-petaflop-ibms-roadrunner-wins-supercomputer-top-spot.html) The National Center for Computational Sciences (NCCS) at Oak Ridge National Laboratory in Tennessee, USA which has several large supercomputers, has a 2008 annual budget between $80 million and $100 million. (reference: http://news.cnet.com/8301-13772_3-9985500-52.html). A typical personal computer might be capable of approximately 4 billion numerical operations per second, so the Blue Gene computer at Los Alamos provides roughly 250,000 times more computing power.

Typically the programming is developed on personal computers, then moved to the larger devices. Usually the expensive supercomputer time is spent primarily on numerical computation, rather than on providing a nice-to-use interface for users. However, the results of a supercomputer may be shipped over the Internet to a personal computer so that a scientist or engineer may mull over the results in a more contemplative way without incurring additional supercomputer costs.

Multiple computers may be linked together over the Internet to get all the pieces of a particular elaborate computation done. This may have the supercomputers performing the massive numerical computations, while other smaller or personal computers linked in may be displaying the results to a distributed team of investigators who are collectively digesting results and steering the ongoing work.

Hand held or mobile devices

Calculators are useful for casual computation, where one wants to figure out the solution to a small problem once. It's easy to punch in a few numbers and operations and to read the answer on the display. As inexpensive and small mobile devices, these are typically more limited in:

1. memory (limits to computation size and to built-in features)
2. energy consumption (slower processor speed)
3. form factor (keyboard and display too small for more than casual technical use)

Typically calculators are not networked, making it harder to share results to transfer them elsewhere to continue the work.
Table 1.2: A high-end calculator in 2009

![TI-Nspire](image)

The TI-Nspire with CAS is a recent generation calculator from Texas Instruments. It can do numerical and symbolic calculations, as well as graphing. According to ticalc.org (http://www.ticalc.org/basics/calculators/ti-nspire-cas.html) it has 16 Mb memory, 20 Mb storage and has a 150 MHz processor. This makes it have about 100 times less memory, 8000 times less storage, and is about twenty times slower than a typical laptop with a dual core 1.5 GHz processor, 2 Gb memory, and 160 Gb disk. Its screen is 240 x 320 pixels, giving it about twenty times less display area than a typical laptop. This is one of the first generation of calculators with limited wireless networking available as an add-on.


Smartphones, personal digital assistants (PDAs), media players have in theory the same processing capabilities as calculators although most of them are not used extensively for technical computation. One advantage of these kinds of devices is that they are typically networked so that it's possible to get a more powerful computer somewhere else in the Internet "cloud" of computational resources to do some of the work.

In the future there may be more convergence of the capabilities of all "mobile small form factor" devices. However the small form factor and the limits to energy consumption will probably continue to constrain the capabilities of such devices compared to larger ones.

**Dedicated controllers**

Even some kinds of toasters have microprocessors in them nowadays. "Smart homes" may network many appliances and home features such as HVAC and lighting control. While these devices are merely configured rather than programmed by end users, students of technical computing should not forget that this is another place where programming is necessary. The economic reasons for switching to computer control of devices appear to be the greater flexibility and variety of control that can be developed at modest cost through programming for many kinds of devices. The kind of programming done for device control often has a mathematical basis. Although the processors in dedicated devices are typically a few orders of magnitude slower than those of personal computers or even smartphones, the programming languages used for them are often the same or similar to those used in personal computing.
1.5 Maple, a system for technical computing

In this course, you will learn how to do various kinds of technical tasks using Maple. The first version of Maple was developed in the early 1980s at the University of Waterloo in Ontario, Canada, but has since undergone many refinements and extension. (In Fall 2010, we will be using Maple 14.) Maple's original emphasis was on algebraic computing, so it was used by those who needed formulas as results for their work. In the early '90s it was used extensively in calculus classes as a way of supporting exploratory experimentation and more extensive experience with "applied" problems. More recently it has expanded its domain into the symbolic, numeric, and graphical calculations done more generally in scientific and engineering modeling and simulation.

Today, Maple supports numerical computing and graphical visualization about as well as it does symbolic computing. It has its own programming language but also has ways of doing calculations through the graphical user interface (GUI) that is a kind of augmented "point and click". The default way of interacting with Maple also allows you to mix documentation and computing instructions and results. Thus it's particularly easy in Maple to produce documents that produce a well-documented solution -- a description of the problem, the explanation for how to solve it, and the computations that produce the details of the answer and evidence to justify its correctness.

1.6 What about Systems X, Y, Z, ...?

There are a variety of systems and programming languages used for technical computing nowadays. In a large technical establishment such as a university or research lab, one might find, in addition to Maple the use of systems such as: Python, Matlab, C, Mathematica, Java, Octave, Macsyma, Sage, Axiom, or Fortran.

The vast array of tasks computers can be used for, the multiplicity of philosophies of system design, and the rapid and unrelenting nature of progress in computing means that there is no "best system" for any situation. Each system has its technical strengths. There may also be historical, cultural, or economic reasons why certain systems are used in certain places which co-exist with the technical justification. As with all popular and demanding activities, there are many products in use.

One important ramification of this is that students in technical fields must expect to become familiar and proficient in more than one programming system. Studying more than one brings greater knowledge of what's possible, and the advantages in judgment that comes from knowledge of diverse ways of achieving a goal. It also allows one to function effectively as a team member in larger cross-organizational efforts and to better to cope with the diversity in computing cultures that's out there.

1.7 Why pick Maple as the first system?

1. It is an interactive system, facilitating quick exploration of new ideas. Compared to languages such as C++ or Java, one can immediately start up an interactive system and calculate results through "point and click" and a little typing. It's also possible to enter computational scripts, which are sequences of steps that are less elaborate to set up than programs. The scripts can be easily re-run on variants of the original situation just by changing a line or two in the script. This allows convenient "what-if" exploration, where a number of different scenarios are explored through computation. The worksheet interface to Maple allows sophisticated mathematical typography and graphics as well as mouse- and palette- driven input.

2. It can handle calculations with formulas. Rather than figuring out the formula yourself, you can even get Maple to calculate the formula for you. While many mathematical calculations produce numerical results, formulas are needed to specify how those results are produced. Designers or developers often need to find and create the formulas rather than to just copy them from a book. A system where formulas are easy to represent and easy to create supports this kind of work. A system that allows you to represent and calculate both numbers and formulas makes it easier to do and document technical calculation than a system that just works with numbers.

3. It supports a variety of data structures that support technical computation: formulas, equations, functions, sets, lists, tables, vectors, and matrices. Rather than having calculations done with a number of digits that's fixed forever, it is easy to change the precision if more (or less) precision is needed. Having higher-level interaction with the computer is usually more productive of human time. Having all of these entities as "first class entities" in the system requires less mental effort by the user, since they
do not have to translate what they are thinking about (e.g. a table of formulas) into the terms that the computer is using. Rather, the computer language accommodates the human style of thought.

4. **It supports documentation as well as calculation.** From the instructor's point of view, it's easier to create documents that explain Maple because we can use Maple both to handle the calculation and the presentation of results. For students, having a file with both the directions that cause the computation and the results makes it easier to present the work cleanly for grading, and for future reference. For professionals doing technical work, having an *integrated environment* where text, programming and results can be combined together can be a convenience.

5. **It has a "conventional programming language".** An objective of this course is to make you become familiar enough with some of the standard elements of programming (e.g. assignments, conditionals, loops, procedure definitions) so that you can use them creatively to handle certain common situations that can't be handled through point-and-click or built-in operations. These elements will be found in highly similar form in the languages used by many other systems used for technical work.

6. **The mathematics of modeling and simulation is an explicit feature of the language.** While its programming language is conventional, Maple's language has an important added plus -- you can work over expressions, equations, functions, and other mathematical objects just as conveniently as if they were numbers or characters. Conventional languages (e.g. Java) can represent arithmetic operations -- multiplication, addition, subtraction, and division -- but after that there are special tricks and conversions that you must perform to bridge the gap between what is written in the program, and the mathematical ideas that you are trying to use in the model. It's more straightforward in Maple to represent the mathematical model and the computation based on it. This ease of expression and comprehension by programmers has a hard-headed dollars and sense payoff. Less programmer time can be spent developing a computation. There is also an efficiency advantage to explicit representation of formulae: it is possible to use systems such as Maple to *automatically* improve the quality and efficiency of simulation calculations. This again leads to lower costs of doing the work.

We think these things provide a software engineering advantage that will lead most technical computation systems to eventually have such functionality built-in into them.

### 1.8 Using more than one system

Any user of computers who expects to use them professionally for design and investigation *must expect to eventually learn multiple systems*. Using computer applications for work is like using tools in a workshop-- you would not expect to use one tool to do all tasks, even if the tool, like Maple, has "Swiss Army Knife" capabilities. Features that make it easier to do certain kinds of things may slow down doing other things. Even when systems overlap in features, they typically have differing philosophies and different technical strengths, which means that certain kinds of work may be significantly easier in one system than another. For example, developing something in Mathematica or Maple may be fine and quick for a personal computer, but making the same programming work on a supercomputer may take a lot of effort in a different language. Yet a work environment with multiple languages need not be overwhelmingly complex. Most systems with major development effort behind them (such as Maple and those mentioned in the "section above) have many similarities.

What makes things work out is this: at the introductory level, the difference between casual computing and professional technical computing is the style of working (higher emphasis on documentation, justification and ease of reuse), and the use of language-based commands/programming needed to do the more sophisticated operations in technical work. "Crossing over" to the professional mode of operation means getting over the hurdles of learning the new style of work, and learning how to interact with computers in a typical computer language. Once this hurdle is passed, it should take only incremental effort to acquire expertise in the second, third, or *n*th technical system. Having formal instruction on the first system should provide an explicit introduction into the concepts and the work processes to facilitate this.

Most systems realize that they cannot be the sole provider of technical computing services. If Institution A uses Mathematica and Institution B uses Python for their work, then if they expect to use each other's efforts, there has to be a way of interconnecting programs written in one system with that of another. Thus most systems have interconnections. For example, the Matlab Symbolic Toolkit allows Matlab users to call Maple to do formula manipulation. Similarly, Maple users can link to Matlab and run a Matlab program they've gotten from a colleague as part of a problem-solving process written in Maple.
Knowledge of basic programming and the concepts of *software development* make it possible to switch between systems with only a modest amount of additional effort. Software interconnection allows one to reuse programming done in another system without having to translate into another language. Symbolic computation systems like Maple also have the additional bonus of being able to translate some of their programming between languages. There is a "convert-to-Matlab" feature for example, or a "convert-to-C" feature for computations involving just numbers or text.
2 Getting started with Maple's Document Mode: doing technical work with a clickable interface

2.1 Chapter synopsis

1. How to start up Maple and perform simple calculations, algebra, and plots within it.
2. Detecting and fixing typographical mistakes.
3. Introducing mistakes caused by vocabulary misunderstandings and the use of incorrect logic in giving directions.
2. How to save Maple work so that you can refer to it or resume working on it later.
3. How to recover a Maple worksheet if it or your computer crashes.

2.2 Starting up Maple, getting a fresh start

Start up the Maple application (this varies on the type of computer system you have, typically it involves clicking or double-clicking on the Maple 13 icon, but if you can't figure it out yourself ask for a demo for someone who knows). Once the Maple application window appears, a new "document" will appear in the main working area of the Maple application. A flashing cursor will appear with the outline of a small rectangle with dashed lines. The entry mode will read "Math" and "2D Math". You can make the "quick help" black box disappear by clicking on the "close box" circle-X in the upper right hand corner.

Table 2.1: Maple started up with new document in Windows XP

![Maple Interface with 'Quick Help' and 'Click on close box' highlighted]
After you close the quick help box, you will see the Maple cursor in a small rectangle with a dashed line outline

Table 2.2: Maple document with first entry area

At this point, what you type will appear in the small rectangle and be regarded as a mathematical expression. In the next section, we describe what to type in order to get something useful to happen.
2.3 Evaluating an expression involving exact arithmetic

Grade school arithmetic

In the math area, type $2 + 3$. "$2 + 3$" is regarded as a mathematical expression by Maple when you type it into the dashed rectangle. As you are typing, the input indicators should say that you are entering Math mode, in "2D Math" input, using "Times New Roman" font:

Table 2.3: Maple input using 2d math

![Maple input using 2d math](image)

This expression should show up in the work area. When you hit the enter key, then Maple will evaluate the expression. After the expression is evaluate, you should see the result displayed below the input, as in the figure below:

Table 2.4: Maple input with labeled result

![Maple input with labeled result](image)

Maple has automatically calculated the answer and given it a label $(1)$. After Maple calculates the answer, the cursor should appear below the result in another dashed-line rectangle. This indicates that Maple is ready to do another calculation.

Maple supports all the basic arithmetic operations in a fashion similar to many other programming languages. One thing that takes some getting used to is that * (asterisk) is used to input multiplication rather than "x" or a centered dot. Another thing that takes some getting used to is that what you type is formatted to look like math notation. Thus if you type a /, Maple understands that you are talking about division and immediately starts formatting your input as if it were a fraction. If you type an asterisk, Maple formats that into a dot (.). There is also formatting that occurs with caret (^) since that is the way you enter an exponent in Maple.
Table 2.5: Arithmetic Operations in Maple

<table>
<thead>
<tr>
<th>Operation</th>
<th>Character to type/ character name</th>
<th>Notes</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>addition</td>
<td>+ (&quot;plus&quot;)</td>
<td></td>
<td>$2 + 2$ (2.1)</td>
</tr>
<tr>
<td>multiplication</td>
<td>* (&quot;asterisk&quot;)</td>
<td>Typing an asterisk makes a center dot (·) appear in the displayed expression.</td>
<td>$2 \cdot 3$ (2.2)</td>
</tr>
<tr>
<td>division</td>
<td>/ (&quot;slash&quot;)</td>
<td>Typing a slash draws a baseline and then positions the cursor in the denominator. Subsequent typing appears in the denominator. To get out of the denominator and return to normal typing, use the right-arrow key (→). Multiple divisions are by default conducted left-to-right.</td>
<td>$\frac{2}{6}$ (2.3) $\frac{1}{3}$ (2.4)</td>
</tr>
<tr>
<td>subtraction</td>
<td>- (&quot;dash&quot; or &quot;hyphen&quot;, typically on the same keyboard key as the underscore. Dash and underscore do not mean the same thing.)</td>
<td>Multiple subtractions are conducted leftmost first.</td>
<td>$3 - 5$ (2.5) $3 - 5 - 7$ (2.6) $-9$</td>
</tr>
<tr>
<td>parentheses</td>
<td>( , ) (&quot;left parenthesis&quot;, &quot;right parenthesis&quot;)</td>
<td>Use parentheses to change the order of calculation. They are also good for removing any</td>
<td>$(2 + 3) \cdot 5$</td>
</tr>
<tr>
<td>Operation</td>
<td>Description</td>
<td>Example</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>negation</td>
<td>&quot;dash&quot; or &quot;hyphen&quot;, typically on the same keyboard key as the underscore</td>
<td>$- (3 \cdot 5 - 2)$</td>
<td></td>
</tr>
<tr>
<td>power</td>
<td>&quot;caret&quot;, typically on the same keyboard key as the number 6)</td>
<td>$2^3$, $2^3 - 5$, $2^{2^{-1}}$, $2^{-2} + \frac{4}{5}$</td>
<td></td>
</tr>
</tbody>
</table>

Guesswork by the reader as the order of operations.

$3 - \left( \frac{2}{5} \right)$

$\frac{29}{15}$

$-13$

$\frac{21}{20}$
Let's try out some of these operations. We can enter a sum of two fractions by using "+" and "/". If we type "2/3+5/6 enter", this is what we see:

\[
\frac{2}{3} + \frac{5}{6}
\]

\[
\frac{3}{2}
\]
We can mix operations. Try to enter and calculate the following:

\[
1 + \frac{2}{3 + 4} + 5 - 6 + 7
\]

\[
\frac{67}{14}
\]

In order to get that last denominator, we had to select the expression we had entered for the numerator with the mouse, so that the entire contents of the entry rectangle were blue. Then we typed a slash and the denominator appeared beneath it all.

An alternative to using the mouse to enter expression (1.2.1.18) would be to use parentheses. If we type ")(1+2/3+4→+5+6+7)/8 enter" we will see this:

\[
\left(\frac{1 + \frac{2}{3 + 4} + 5 - 6 + 7}{8}\right)
\]

\[
\frac{67}{14}
\]

This allows you to enter complicated expressions without having to use the mouse. Of course, the mouse is still necessary if you want to go back and edit.

We observe in passing that a distinctive feature of Maple is that Maple does \textit{exact arithmetic with integers and fractions}. It keeps fractions as the ratio of two integers. It will, however, automatically simplify such ratios to lowest terms:

\[
\frac{2}{3} \cdot \frac{6}{7} = \frac{18}{21}
\]

\[
-2
\]
Making typographical mistakes

Making mistakes is a normal part of using any tool, be it a computer or otherwise. You'll probably make as many mistakes learning how to use Maple as you would make when learning a new sport, a musical instrument, or when learning how to write a good essay. Some of them will be obvious as soon as you make them, others will be subtle or harder to figure out how to fix.

When you make some kinds of mistakes, the computer may give you an error message. For example, if you make a typo and Maple doesn't recognize what you enter as being a valid command, it will complain. Here are some typical error messages. At this stage, some of the messages will make sense and you can react appropriately. Others will use vocabulary that is unfamiliar. For those, the best thing to do is to have a clear idea of what you want to enter (by closely imitating examples that are known to work) and checking carefully that what you have typed was accurate.

Table 2.6: Examples of Maple error messages

<table>
<thead>
<tr>
<th>Expression</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 +</td>
<td>Error, invalid sum/difference</td>
</tr>
<tr>
<td></td>
<td>![Error Symbol]</td>
</tr>
<tr>
<td>2 + 4</td>
<td>We intended to enter &quot;2 + 4&quot; but forgot to type the &quot;4&quot; before we hit enter (return). The appropriate thing to do here is to correct the expression and hit enter again.</td>
</tr>
<tr>
<td></td>
<td>![Corrected Expression]</td>
</tr>
<tr>
<td>+ 24</td>
<td>Error, missing operation</td>
</tr>
<tr>
<td></td>
<td>![Missing Operation Symbol]</td>
</tr>
<tr>
<td>. + 4</td>
<td>This time we mistakenly enter the expression with the symbols in the wrong order. Maple complains that it expects some operation to be entered between the two numbers but there isn't one.</td>
</tr>
<tr>
<td></td>
<td>![Wrong Order Symbol]</td>
</tr>
</tbody>
</table>
We intended to enter "2+4" but typed a period instead of a 2 by mistake. Even though we are trying to do the same thing, the error message is different because a different symbol (the period) in this context suggests to Maple that we are trying to do linear algebra. The appropriate thing to do here is to correct the expression and hit enter again.

\[ 2 + 4 \]

\[ 6 \]  

(2.26)

We started a sub-expression with a parentheses but forgot to finish it. In Maple, a delimiter refers to a parenthesis -- ( or ) -- a bracket [ or ], or a brace { or }. Delimiters are symbols that mark the beginning and end of an expression. In many instances they are necessary to unambiguously indicate meaning. For example \( 5 \cdot (3 + 5) \) evaluates to 40, where as the expression without parentheses \( 5 \cdot 3 + 5 \) means 20 because multiplications are always done before additions unless the parentheses indicate otherwise.

\[ \left( 3 + \left( 5 + \frac{3}{7} \right) \right) \cdot 2 \]
Error, unable to match delimiters

```
3 + \left( \frac{5 + \frac{3}{7} \cdot 5}{2} \right)
```

This is another instance of the same mistake. We wanted to enter \(3 + \left( \frac{5 + \frac{3}{7} \cdot 5}{2} \right)\) but misplaced several parentheses.

```
, 1 + 3
```

Error, invalid sequence

```
, 3, 3
```

We intended to enter "1+3" but typed the extra comma in by mistake. We get an error message that talks about sequences, a concept in Maple that we haven't discussed yet (that's coming in the next few chapters). Maple thinks that the sequence is "invalid" because it usually expects commas to be between items, such as "1,2,x".

Maple's language has many other elements in it that we haven't gotten to discuss yet. If you use any of them by mistake then you will see messages with vocabulary we haven't discussed yet.

It's a fairly typical experience for new users to see some messages that you won't be able to gather much intelligence from other than the fact that you made a mistake that you should fix,. With knowledge-rich systems such as Maple, you may blunder into sections of the system that you haven't learned yet. The best strategy is to back out of the situation by editing the expression so that it is exactly like something that is known to work.

```
2 + \frac{1}{3}
```

Error, invalid fraction

```
2 + \frac{1}{3}
```

This one is fairly obvious. In order to fix it though, we need to know what denominator we intended to enter.

```
2 + \frac{9}{3}
```
Correcting typographical mistakes

The standard procedure for fixing a mistake is as you would in a word processor: *edit the mistaken input* and *re-execute the computation*. Here are ways of doing this:

1. Using the mouse, position the cursor where the mistake is. Then use the backspace key to erase the characters you want to get rid of. Type in more characters to replace it.
2. Use the left arrow key (←) to back up. Typing after backing up then inserts the new typing at the point where the cursor was positioned.
3. Use the mouse or other "pointing device" of your computer to select a section of what you typed. New typing then replaces the selection of what you typed.
4. Use the mouse to select a region, then "cut", which you can do through the Maple menu Edit -> Cut. Of course most people use the keyboard shortcut for cutting, which for Windows or Linux is control-X while on the Mac it's command-X.
5. Copying and pasting (control/command-C and control/command-V) also works in Maple.
You may find that sometimes you attempt to create a 2D Math input area but Maple does not compute a result for the input after you hit the enter key. To create a "clickable math" input area if this happens, place the cursor where you want the input area to be, and use the Format->Create Document Block Menu item of the Maple window:

Table 2.7: Create Document Block to force a Math input area wherever the cursor is placed

---

**Exponentiation (powers). Numbers with lots of digits**

Use a caret (^) to specify an exponent (a "power"). In math mode, Maple will position the cursor so that the next things you enter will become the exponent. As with fractions, you can get out of the exponent by using the right arrow key → when you want to go back to non-exponent numbers. Try entering these expressions

\[ 2^3 \]

\[ 8 \]  

\[ \frac{2^{1000} - 2}{2} \]

\[ (2.30) \]

\[ (2.31) \]
We note that Maple does integer and fraction operations exactly. It will not introduce any rounding error into a computation as a calculator would when the answer requires more than ten decimal digits to write down.

There are limits to the number of digits Maple will use for integers or fractions, but they have to do more with ultimate limits of the computer hardware and memory rather than a "pre-ordained" decision about how many digits might be useful to keep. If you type kernelopts(maxdigits) into a Math input area on the worksheet, Maple will print out a number which is the maximum number of digits it can handle in any integer or fraction. On the author's computer,

\[
\text{kernelopts(maxdigits) = 268435448}. \text{ Note that this is not the value of the maximum number, but how many decimal digits the largest number can have.}
\]

For example, Maple can compute the result of

\[
\frac{1}{52!} + \frac{2^{100}}{3^{27}} \text{ exactly (try it!).}
\]

Exact computation is useful not only for doing algebra but also for things such as computing probabilities through counting, or in deriving mathematical formulas for use in simulation or prediction programs.

**Detecting and fixing vocabulary and "logic" mistakes**

There will be other kinds of mistakes where there is no error message, but the response is not what you want. Sometimes this happens because you say something that while grammatical, means something entirely different from what you meant. This could be as simple as entering "2-3" where you meant to type "2+3". Sometimes it is less obvious, such as mistyping the 23-rd digit of a 55 digit number or the 12th term of a long sum. Or worse yet, it could be because you are using the incorrect vocabulary so what you think you are saying does not have that meaning to the computer.

**Table 2.8: Example of a vocabulary mistake**

<table>
<thead>
<tr>
<th>2x3 + 5</th>
<th>2x3 + 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>[2 \times 3 + 5]</td>
<td>[2 \times 3 + 5] (2.32)</td>
</tr>
</tbody>
</table>

Suppose we were under the (mistaken) impression could use "x" in Maple to stand for multiplication. We might use the above as a way to calculate "two times three, plus five". However, while there is no error message, what is calculated is not the number we were expecting. The first step towards proceeding to fix this is to realize that it's not what we want. To Maple, this is a legitimate calculation -- you want to create a formula that's "two times the variable x, plus five".

<table>
<thead>
<tr>
<th>2·3 + 5</th>
<th>11</th>
</tr>
</thead>
<tbody>
<tr>
<td>[2 \cdot 3 + 5]</td>
<td>[11] (2.33)</td>
</tr>
</tbody>
</table>

Knowing that the proper way to enter multiplication is through a palette, or symbol "+" (asterisk) as explained in
Finally, there are mistakes made because *you ask Maple to do the wrong calculation*. Even though Maple does what you want, it turns out that what you wanted was wrong!

For example, you may read a word problem and decide to solve the equation $3 \cdot x + 2 = 6$, whose solution is $x=4/3$. But when you plug the solution into the circumstances of the problem, you find that it doesn't solve the word problem. The problem may be because you used faulty logic to decide that $3 \cdot x + 2 = 6$ was the equation, but it was actually $2 \cdot x + 4 = 6$. This is known as an "error in logic" or just a "logic error".

Sometimes it's obvious that you made a mistake because the answer is obviously wrong. For example, seeing "-1" when you are expecting the answer to "2+3" is obvious because you know already that you shouldn't get an answer which is a negative number. Sometimes it isn't so obvious, so you need a way to check the correctness of the result.

### 2.4 Saving and retrieving your work

You can save your work in a Maple worksheet file through the File -> Save (keyboard shortcut: control/command-S) menu item of the Maple application. A dialog box appears allowing you to type in the name of the worksheet (we've typed in "test" into the box in the .)

The file is saved with a ".mw" suffix (e.g. test1.mw).

To retrieve the file in a subsequent Maple session, start up the Maple application as before and then use the File->Open menu item to initiate the dialog that retrieves the file.

**Table 2.9: Maple save menu operation**

![Maple save menu operation](image)
2.5 Retrieving backups

The "state of Maple" display appears on the bottom left hand side of the Maple window. Usually this display says "Ready", which means that Maple is awaiting your next command. Sometimes it reads "Evaluating..." which indicates that Maple is actively computing an answer. Sometimes it says "Autosaving worksheet", which means that it is saving a copy of the present state of your open worksheets into temporary storage on your computer. The amount of time Maple spends autosaving becomes noticeable in longer Maple sessions when the worksheet contains a lot of results.

Should your computer suddenly lose power or should Maple crash, you can retrieve the last autosaved worksheet by selecting the File -> Recent Documents -> Restore Backup menu item. This will fill your Maple with copies of all the autosaved worksheets. You may then delete them or save them to permanent file space as you wish.

Table 2.11: The Maple state display
2.6 Algebra, plotting and mouse-clickable operations

Algebraic expressions and equations. Solving equations. Working with pieces of expressions.

We don't have to limit ourselves to just numerical calculation in Maple (even if the ability to use as many digits as we wish and exact fractions allows us to do arithmetic more like the math books do). Another distinctive feature of Maple is that you can do algebra by entering expressions with symbols -- the $x, y, z, i,$ and $n$ that we see in algebra books. Maple will automatically collect terms and do some simplifications for us automatically

$$x^2 + 2x + 5 + 3x$$

(2.34)

We can even enter equations:

$$\frac{3}{5} x + 1 = 4 - x$$

(2.35)

$$3x + 1 + 4x = ax + b$$

(2.36)

Note that while Maple automatically collected the $x$ terms on the left hand side of the equation, it does not try to do the more interventionist operation of moving all the $x$ terms to the same side of the equation.

Now, enter the following expression, but rather than hitting the enter key after you've entered it, do a right-click. On the Mac, instead of right-clicking hold the control key down then click on the mouse button (this is referred to as "control-click"). A menu of algebraic operations will pop up. Select Factor and see how Maple can factor the polynomial:

$$x^2 + 5x - 50 = \text{factor} \ (x + 10) (x - 5)$$

Note that this line does not have a (XX) label for it.

To further demonstrate the right-click (control-click) operations available, enter the following equation. Right click on the expression and a pop-up menu should appear that includes a "solve" item. Select the solve and a submenu will appear where you can specify that you want to solve for $x$.

$$\frac{3}{5} x + 1 = 4 - x \ \xrightarrow{\text{solve for } x} \ [x = \frac{15}{8}]$$
For those with previous experience on other systems: some things are different, for a reason

(This section is for people who already know a programming language and are noticing that Maple does some things differently. Other readers can skip this section.)

Most mainstream programming languages work in a similar way. That is why learning Maple has value beyond just being able to use the Maple system -- once you learn Maple, learning Matlab or Java or C is a matter of incremental adjustment. Noticing the differences is educational in that it makes you become aware of the arbitrariness of some of features of languages. If you have used another programming language such as Java or Visual Basic (VB), you will notice that some things do not work the same in Maple as they do there. Some of this can be explained if you know something about the history of programming languages. Some of it is explained by being aware that the designers of Maple had different goals than those who invented Java or VB.

One thing that you have undoubtedly noted is that symbols do not have to have a value associated with them. For example, in Java if you said

\[ k = 5; \]

Then if you were to create another expression in Java such as System.out.println(k*2 + k + 3); then "5" would be used as the value of \( k \) in the expression and you would end up printing 38. In Maple, you do not have to associate \( k \) with a numerical value before you use \( k \) in an algebraic expression. If there is no prior association, Maple just treats the expression as a formula with symbols in it. It may do some algebraic simplification on what you entered, but it does not need to get a number as a result. Since there was no prior assignment for the expressions in section 2.5.1, the calculation done with them just keeps the formula.

Another thing that is different is that in Maple "=" is used for equations, not assignment. The operator in Maple corresponding to "=" in Java or VB is ":=" (a colon immediately followed by an equals, with no spaces in between). In Maple, if we wanted to associate "5\( k \) with the symbol \( k \), then we would do:

\[ k := 5 \]

\[ 5 \]

\[ k^2 + k + 3 + k \]

\[ 38 \]

Is ":=" better than "="? That's a kind of question that is about as hard to answer as trying to decide whether "uno" is better than "one". If one had a language where you had to "\( \left\langle \text{---*\%\%\%+++-}\right.\) instead of "=" or ":="), you could be critical of the choice because it takes much more effort to enter a 35 character operator than a one or two character one. But the Algol-family choice of "=" has reasonable motivation -- studies of novice programmers have shown that beginners using languages where "=" is the assignment make more mistakes because they confuse its use in mathematics with its use in programming. Novices have been observed to write things like "5=k" which does not work as an assignment, even though mathematically the equations "\( k=5 \)" and "\( 5=k \)" mean the same thing.

Just as with architectural design of a building, each feature of a programming language is typically carefully considered. Many features are borrowed or copied from predecessor languages, where they have already been subjected to the test of many people using the feature. If you are not familiar with Algol family languages, you can see examples of them at various educational web
sites, such as http://www.engin.umd.umich.edu/CIS/course.des/cis400/algol/average.html and http://portal.acm.org/citation.cfm?id=154766.155365.

People who know more than one programming language have a better understanding of which features are change a lot between languages, (such as whether = or := is used for assignment), and which ones are fairly uniform (+ being used for addition, or the use of parentheses in functions and expressions).

Maple does not use "=" for assignment because, being a mathematically oriented language that can handle algebra, it wants to make the entry of equations a natural thing. Its use of ":=" for assignment is a feature borrowed from the Algol/Algol 68/Pascal family of programming languages, which picked this operator to make it clear that the assignment operation is different from algebraic equality.

### Plotting and approximate numerical solutions

The right-clickable interface can also activate a plot of a formula you may have entered. Enter this formula, then right-click and select **Plot ->2d plot**. The automatic defaults for plotting this produce this result.

**Table 2.12: Example of Plotting**

![Plot of the equation $x^2 - 10 \cdot x + 4$](image)

If we click on the plot and then position the mouse over the plot area, we see in the upper left hand corner of the Maple application a pair of coordinates that change as we move the mouse around. We can "eyeball" the plot with this to find approximately where this formula is equal to zero. From the figure below we can see that $x^2 - 10 \cdot x + 4$ is zero at about .5 and again at about 9.

While we could draw a bigger plot centered on the region of interest, a faster way of getting more information is this: find **Plot** in the menu bar and go to the Probe Info option in this menu. Select **Cursor Position**. Once this is done, whenever you position the cursor over the plotted curve, the coordinates of the cursor's position will pop up.
Table 2.13: Plot created by right-click -> Plot -> 2DPlot

User has clicked on the plot and positioned the cursor at the coordinate (-4.12, 61.60). The cursor was not captured by the screenshot although it is visible under ordinary use.

The 2DPlot operation makes pre-set decisions about the plot, such as the range of \( x \) (-10 to 10), the color of the line, axes labelling, etc. Users can inject their own preferences about these things about this by selecting right-click -> Plot -> PlotBuilder and filling in the dialog box with their choices.

Table 2.14: User-configured plot using PlotBuilder instead of 2DPlot

\[ x^2 - 10 \cdot x + 4 \]
The Expressions Palette and the Common Symbols Palette: entering Trigs, logs, roots, exponentials

It's possible to get the common functions of high school algebra, pre-calculus, and calculus by using the Expression palette of the Maple Window:

Table 2.15: The Expression palette

For example, to enter the square root of 36, click on the palette entry for \( \sqrt{a} \). That expression will appear in the document, with the "a" selected. If you then type 36 on the keyboard, that number will replace the selected text. If you then hit the enter key, Maple will evaluate the expression and produce the exact result "6".

\[
x + y + \frac{1}{2} + \frac{1}{4} + \sqrt{36}
\]

\[
x + y + \frac{27}{4}
\] (2.39)
You can use the palette multiple times, to create more complicated expressions. Just continue to the use mouse or the arrow keys to move around in the expression. Selecting and typing, backspacing or deleting are all ways of replacing or correcting pieces of the expression.

The Common symbols palette, two panels below the Expression palette, can be used to enter $\pi$ and $e$, the base of the natural logarithm system.

The palette does not have the inverse trig functions, so you have to enter them through typing. Their names are: arcsin, arccos, arctan, etc.

**Table 2.16: Examples of palette-driven computation**

\[
\sin\left(\frac{\pi}{4}\right) + \cos\left(\frac{\pi}{4}\right) = \sqrt{2}
\]

\[
\left(\sqrt{1024} + \ln\left(\frac{2}{3}\right)\right) \cdot \pi = \frac{98}{39} \pi
\]

\[
\arcsin\left(\sin\left(\frac{1}{4} \cdot \pi\right)\right) = \frac{1}{4} \pi
\]

**Approximate numerical (calculator - type) arithmetic in Maple**

If you enter expressions with integers, exact fractions, and symbols such as $\pi$ and $e$, then Maple will perform exact calculations rather than give approximate answers as a conventional calculator would. You can get approximations by selecting the "numerically solve" instead of the "solve" option from the right-click pop-up menu.

**Table 2.17: Examples of computing with approximate solving**

<table>
<thead>
<tr>
<th>$x^2 - 10x + 4 = x^2 - 10x + 4$ solve</th>
<th>Exact solution of an equation using the &quot;solve&quot; feature of the pop-up menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>${x = 5 + \sqrt{2}\Gamma}, {x = 5 - \sqrt{2}\Gamma}$</td>
<td></td>
</tr>
</tbody>
</table>
\[
x^2 - 10x + 4 \rightarrow \text{solve} \quad 0.4174243050, 9.582575695
\]

Using the "numerically solve" feature of the pop-up menu

If you have an exact expression, you can ask Maple to approximate it to 5, 10, 20, or more digits. In this mode, Maple can be used as a super-accurate calculator.

**Examples of numerical computation**

1. Enter fraction, select approximate->20 from right-click pop-up menu.

\[
\frac{47}{52} + \frac{4}{3} \quad \text{at 20 digits} \Rightarrow 2.237194871794871795
\]

2. Enter exact expression, select approximate->5 from right click pop-up menu

\[
\sin\left(\frac{\pi}{10}\right) \quad \text{at 5 digits} \Rightarrow 0.30902
\]

3. Enter equation. Then solve->solve, then select Element->1, then right hand side, then approximate->10

\[
\sin\left(\sqrt{e^x}\right) = \frac{1}{3} \quad \text{solve} \Rightarrow x = 2\ln\left(\arcsin\left(\frac{1}{3}\right)\right) \Rightarrow \text{select entry 1} \Rightarrow x = 2\ln\left(\arcsin\left(\frac{1}{3}\right)\right) \Rightarrow \text{right hand side} \Rightarrow 2\ln\left(\arcsin\left(\frac{1}{3}\right)\right)
\]

\[
\text{at 10 digits} \Rightarrow -2.158578910
\]

**Evaluation, and selection of pieces.**

Sometimes you wish to evaluate an expression for a particular value of a variable. There is a right-click operation that does this.

**Table 2.18: Evaluate at a point**

<table>
<thead>
<tr>
<th>Expression</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>(x^2 - 2;\cdot x = 0)</td>
<td>evaluate at point</td>
<td>(\frac{1}{4} - a = 0)</td>
</tr>
<tr>
<td>(x^2 - 2;\cdot x = 0)</td>
<td>evaluate at point</td>
<td>(x^2 - 6;\cdot x = 0)</td>
</tr>
<tr>
<td>(3;\cdot y + 5)</td>
<td>evaluate at point</td>
<td>14</td>
</tr>
</tbody>
</table>

Using the right-click menu, it's possible to select or extract a portion of an expression for further work.

**Table 2.19: Operations on equations, multi-part expressions**

<table>
<thead>
<tr>
<th>Expression</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>(x = \frac{\sin(a)}{r^2 - 1})</td>
<td>right hand side</td>
<td>(\frac{\sin(a)}{r^2 - 1})</td>
</tr>
<tr>
<td>(x = \frac{\sin(a)}{r^2 - 1})</td>
<td>left hand side</td>
<td>(x)</td>
</tr>
</tbody>
</table>

**Operations on multi-part expressions**

<table>
<thead>
<tr>
<th>Example</th>
<th>Value</th>
</tr>
</thead>
</table>

8VLQJ WKH QXPHULFDO VROYH IHDWXUH RI WKH SRSXS PHQX
2.7 A quick-reference summary to this chapter

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arithmetic</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$2 + \frac{3^2}{4} - \frac{1}{6}$</td>
<td>Use +, *, -, /, ^ for arithmetic. Hitting the Enter key produces a labelled result.</td>
<td>2 D Math input mode displays the textbook-like version of what you input. Maple's simplification automatically combined fractions and places things in lowest terms.</td>
</tr>
<tr>
<td>$\frac{49}{12}$</td>
<td>(2.43)</td>
<td></td>
</tr>
<tr>
<td>$5!$</td>
<td>Use ! for factorial</td>
<td>Do you know what 5!! (double factorial) means?</td>
</tr>
<tr>
<td>$120$</td>
<td>(2.44)</td>
<td></td>
</tr>
<tr>
<td><strong>Making mistakes</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$2 + \left( \frac{3}{5} \right)$</td>
<td>Error message mistakes (from typos or mistakes in intensions)</td>
<td>The easiest ones to detect. You have to figure out what you are doing wrong, though. The error message may not always be helpful in advising you on this, although it often is.</td>
</tr>
<tr>
<td>Error, unable to match delimiters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A farmer plants a fence post every foot, for 1250 feet. At that point, he switches to planting the fence posts every 4.7 feet for another 940 feet. How many fence posts does he need in all?</td>
<td>&quot;Logic errors&quot;</td>
<td>You are asking Maple to compute something that it understands, so it gives you an answer. However, this answer doesn't really solve your problem. You need to find a more appropriate computation, which you can only do by thinking about whether you are asking the computer to do something different from what is needed. Often you can find these kinds of mistakes by</td>
</tr>
</tbody>
</table>
Maple did do the arithmetic in the above calculation correctly. The problem is that it's the wrong calculation. Do you see how to get the right answer?

Looking at simpler versions of the problem where the answer can be figured out with paper and pencil. Then you can "scale up" the answer to handle the actual problem you have.

The correct answer is 1251 + 201 1452 fence posts. The computer did what it was asked to do -- the problem was that it was asked to do the wrong thing.

**Editing (fixing mistakes)**
- Backspace, delete erase starting from current cursor selection
- Arrow keys→ move cursor within current selection
- Select with mouse/type replaces selected text
- Cut, copy and paste of a selection works as it does with a text processor

**File saves, opens**
- Save files with File -> Save or File -> Save As.
- Open a saved file with File -> Open. Other File operations are similar to that of standard word processors.

**Functions and math symbols**

\[
\sqrt{3} \csc \left( \frac{\pi}{2} \right) + e
\]

\[
(1 + e)^{1/3}
\]

Insert math into an expression by using the Expression Palette. You can enter \( \pi \) using the Common Symbols Palette. \( e \) (the natural logarithm base) can also be entered this way. Note: typing \( e \) from the keyboard does not enter this symbol.

\[
\ln(e^2\sqrt{e}) \quad \text{simplify symbolic} \rightarrow \frac{5}{2}
\]

If you are entering a function by the keyboard rather than the palette, you must enclose the function's argument in parentheses.

**Algebra**

\[
x^2 - 2x - 15 = 0 \quad \text{left hand side}
\]

\[
x^2 - 2x - 15 = (x + 3) (x - 5)
\]

Right-click (control-click on Mac) on an entered expression to get the pop-up menu.

Chapter 2 demonstrated examples of the following operations:

<table>
<thead>
<tr>
<th>factor</th>
<th>solve</th>
</tr>
</thead>
<tbody>
<tr>
<td>solve numerically</td>
<td>right hand side (of an equation)</td>
</tr>
<tr>
<td>left hand side (of an equation)</td>
<td>select (n-th part) of an expression</td>
</tr>
<tr>
<td>approximate numerically (to 5, 10, 20, etc. digits' accuracy)</td>
<td>plot (two dimensional) -- many plot options to determine range and domain of plot, color, captions, etc.</td>
</tr>
<tr>
<td>evaluate at a point (choose values for)</td>
<td></td>
</tr>
</tbody>
</table>

Chapter 2 demonstrated the following functions and symbols:

- Square roots, \( n \)-th roots
- Natural logarithms
- Trig functions: \( \sin, \cos \) (trig functions all use radians, not degrees)
- Base 10 logarithms
- \( \arcsin, \arccos, \arctan \)
- \( \sec, \csc \)
- Summation
- \( \pi, e \)
### Plots—2d plot

<table>
<thead>
<tr>
<th>Plot</th>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Graph" /></td>
<td>$x^2 - 1$</td>
<td>The expression must be something that involves a single variable and will result in a number when a value is used for that variable. Thus you can't do a 2d plot of $x^2 - a$ because you wouldn't get a number if you picked a value just for $x$ (or just for $a$). Maple uses defaults for the plot range, and the plot color. Trying to plot an equation produces an implicit plot (see next appendix).</td>
</tr>
</tbody>
</table>

### Plots—plot builder -> 2d plot

<table>
<thead>
<tr>
<th>Plot</th>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Graph" /></td>
<td>$x^2 - 1$</td>
<td>A dialog box appears that allows you the select from many more options, such as plot color, the line style, vertical and horizontal ranges, captions, etc.</td>
</tr>
</tbody>
</table>

### Limited precision (decimal point) numbers

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\cos(x^2) = \sqrt{x} \quad \text{solve} \quad 0.7352027350$</td>
<td>Exact numbers in Maple have no decimal points.</td>
</tr>
<tr>
<td>$1 + \frac{2}{3} + \tan(1) + \pi^e$</td>
<td>Symbolic constants such as $\pi$ and $e$ entered from the Common Symbols Palette are also exact. Numbers with decimal points in Maple cause arithmetic calculations to be done approximately. solve-&gt;numerically solve produces approximate solutions</td>
</tr>
<tr>
<td>$0.766666667 + \tan(1) + \pi^e \quad (2.47)$</td>
<td>Use of limited precision numbers in algebra (e.g. factoring, differentiation, solving) may not produce good results. Use them in Maple only when an approximate result is desired. Numbers like .25 or .6015 are limited precision. If you want exact algebra done, use 1/4 or 6015/10000, etc. In very large calculations, limited precision calculations may be noticeably faster than those with exact arithmetic. Most of the time there isn't an appreciable difference.</td>
</tr>
</tbody>
</table>
2.3240743913549022305 + 3.1415926535897932385

.right-click->approximate->\( n \) takes an exact numerical expression and approximates it.

<table>
<thead>
<tr>
<th>Evaluate at a point</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ x^2 - 2a\cdot x = 0 ] evaluate at point</td>
<td>[ \frac{1}{4} - a = 0 ]</td>
</tr>
<tr>
<td>[ x^2 - 2a\cdot x = 0 ] evaluate at point</td>
<td>[ x^2 - 6y^2\cdot x = 0 ]</td>
</tr>
<tr>
<td>[ 3\cdot y + 5 ] evaluate at point</td>
<td>14</td>
</tr>
</tbody>
</table>

This operation will give a pop-up menu that will allow us to choose values for all the variables. In the first example, we we picked 1/2 for a value of \( x \). Note that the pop-up menu will show what you typed rather than displaying 2D math. In the second example, we specified "3*y-2" as the value for \( a \). In the third example, we picked 3 as the value for \( y \).

<table>
<thead>
<tr>
<th>Operations on equations</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>right hand side, left hand side</td>
<td>[ x = \frac{\sin(a)}{r^2 - 1} ] right hand side [ \frac{\sin(a)}{r^2 - 1} ]</td>
</tr>
<tr>
<td></td>
<td>[ x = \frac{\sin(a)}{r^2 - 1} ] left hand side ( x )</td>
</tr>
</tbody>
</table>

One of the options in the right-click menu is "right hand side". It only works for equations.

<table>
<thead>
<tr>
<th>Operations on multi-part expressions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>select entry</td>
<td>[ x^2 - 4\cdot x = 4 ] solve for ( x )</td>
</tr>
<tr>
<td></td>
<td>[ [(x = 2 + 2\sqrt{2}), (x = 2 - 2\sqrt{2})] ]</td>
</tr>
<tr>
<td></td>
<td>select entry 1 [ x = 2 + 2\sqrt{2} ] at 5 digits</td>
</tr>
<tr>
<td></td>
<td>select entry 1 [ x = 2 + 2\sqrt{2} ]</td>
</tr>
<tr>
<td></td>
<td>[ x = 4.8284 ]</td>
</tr>
</tbody>
</table>

Solving this quadratic equation reveals that there are two solutions. Right clicking on these selections and then select entry \( \rightarrow 1 \) produces the first solution. We can then approximate it by using the

Enter an expression in a document, then right-click (control-click on Mac) followed by: | Commentary |
| Operations on symbolic expressions | Example | |
| solve->solve | \[ x^2 - 1 \] solve | \( \{ x = 1 \}, \{ x = -1 \} \) |
| solve->solve for a variable | \[ x^2 - 2a\cdot x = 0 \] solve for \( x \) | \( \{ [x = 0], [x = 2a] \} \) |
| solve->numerically solve | \( x = \cos(x) \) solve | 0.7390851332 |

The thing to try when there is a numerical answer but the exact solution is too complicated to understand or Maple can't find an exact solution.
### Factoring

\[
x^2 - 1 = \frac{\text{factor}}{(x - 1)(x + 1)}
\]

\[
\cos(x)^2 - \sin(x)^2 = \frac{\text{factor}}{(\cos(x) - \sin(x))(\cos(x) + \sin(x))}
\]

Factoring can simplify an expression sometimes. Factoring doesn't know the trig simplification rules, though.

### Plots—2d plot

\[
x^2 - 1 \rightarrow
\]

The expression must be something that involves a single variable and will result in a number when a value is used for that variable. Thus you can't do a 2d plot of \( x^2 - a \) because you wouldn't get a number if you picked a value just for \( x \) (or just for \( a \)). Maple uses defaults for the plot range, and the plot color.

### Plots—plot builder -> 2d plot

\[
x^2 - 1 \rightarrow
\]

A dialog box appears that allows you the select from many more options, such as plot color, the line style, vertical and horizontal ranges, captions, etc.

<table>
<thead>
<tr>
<th>Operations on equations</th>
<th>Example</th>
</tr>
</thead>
</table>


right hand side, left hand side  |  \( x = \frac{\sin(a)}{r^2 - 1} \)  |  right hand side  |  \( \frac{\sin(a)}{r^2 - 1} \)  |  left hand side  |  \( x \)  

move to right, move to left  |  \( x^2 + x + 1 = a \)  |  move to right  |  \( 0 = a - x^2 - x - 1 \)  |  This moves the entire side of an equation to the other side.

<table>
<thead>
<tr>
<th>Operations on constant expressions</th>
<th>Example</th>
</tr>
</thead>
</table>
| approximate->5 (or 10, 20, 50)    | \( \tan\left(\frac{\pi}{10}\right) \cdot \sqrt{\frac{1}{e^{10}}} \)  | at 20 digits  | 0.34157868529293212152  | Uses approximation methods to turn constants into an approximate (decimal point) number with 5 (10, 20, 50) digits.  
|                                   | \( x = \ln(5000!) \)  | at 20 digits  | 0.375911435088767666569  |
3 Chapter 3 Technical word processing

3.1 Chapter Overview

We learn how to use Maple as a word processor. This allows us to "write up" reports, combining technical writing with math formulae, calculated results, pictures, tables, etc. Many of the features are highly similar to Microsoft Word or similar WYSIWYG (what you see is what you get) word processors. The strength of Maple's word processing is that it makes it easy to enter technical formulae, and that the word processing and calculation can be done in the same document.

3.2 Maple as a word processor

Maple documents allow a mixture of text and mathematics. By default, Maple expects that when you position the cursor by clicking somewhere in the document, you will be entering math and be wanting it do to a calculation. The document is in what is called math entry mode.

Table 3.1: Maple in math entry mode

![Math button on Maple toolbar](image)

You can tell whether the document is in math entry mode because the Math button on the Maple toolbar will be gray, and the "C" menu item says 2D Math.

The other mode of operation for Maple documents is text mode. When in text mode, Maple has the behavior of a word processor. It just shows what you typed. Hitting enter while you are in text mode just causes text entry to move to the next line. It does not cause any calculation to be done with what you typed.
You can switch to entering text in the following way:

1. Position the cursor at the spot where you want to enter text.

2. Click on the **Text** button on the Maple toolbar. This places the Maple document in **text entry mode**. Alternatively you can switch to Text mode by typing control-T (on Macintosh, command-T) or by using the Maple menu bar Insert->Text. You can tell when you've switched to text entry mode because the Text button will be gray, and the "C" menu item says **Text**.

3. With the keyboard, enter your verbiage. When you are in text mode, you will also see that the menu bar will be enabled for boldface, italics, underlining, left-/center-/right- justified text, colored text, and colored backgrounds, and bulleted/numbered text.

4. To switch back to math, click on the **Math** button on the Maple tool bar. Alternatively you can type control-R (on Macintosh, command-R) use the Maple menu Insert->2-D Math.

**Table 3.2: Document after control-T (or Insert->Text)**

A Maple worksheet in text mode in OS X. Although it is hard to see, the cursor is positioned at top left of screen.

You do mathematical word processing without any computation by switching between text and math modes, using the Palettes to help you enter the math. As long as you don't hit the **return (enter)** key, the math will not cause any calculation.
Richard saw in his physics textbook, *Stephen Hawking for Dummies*, a description of Newton’s law of gravitation:

\[ F = \frac{G \cdot m_1 \cdot m_2}{R} \]

where it was expected that \( m_1, m_2, \) and \( R \geq 0 \). Although he didn’t consider himself a strong physics student, he was glad that hadn’t dumbed down the material so much that it lost all the mathematics.

The user typed the text, then went into math mode by typing control-R (command-R). They then entered the "F = G..." formula in math mode. The user got the subscripts \( m_1 \) by typing an underscore \( _ \) after the \( m \) to get Maple to descend to subscripts, then used the right-arrow key to ascend back up to the main level of the expression. The other symbols in the midst of the rest of the narrative are entered in a similar way.

It is possible to mix text and the results of calculations in a paragraph. Typing control-\( = \) (command-\( = \)) when the cursor is in a math expression will cause Maple to print an "=\( =\)" and then the result of evaluating the expression on the same line. This is an alternative to hitting the enter key and allows those kinds of calculations to be mixed with text.

Table 3.4: control-\( = \) puts the results of a calculation in the midst of text

The user entered text, then did a control-R (command-R), then entered the math expression and then typed control-\( = \). After the calculation result appeared, they typed control-T and entered the remainder of the sentence.
3.3 Shortcuts to entering math symbols

Using the Palettes, we can enter a wide variety of mathematics -- expressions, math symbols, Greek letters (using the Greek Palette), arrows, etc. There are additional Palettes not shown by default, which you can get by View → Palettes → Show All Palettes. However, you can enter many symbols in math mode from the keyboard through "shortcuts". Most of the shortcuts consist of typing the textual name of the symbol or some abbreviation of it, and then hitting the escape key -- the key labelled Esc on many keyboards.

For example, to enter the symbol $\infty$ while in math mode, you can type infin and then hit the escape key. A pop-up menu of choices will appear to allow you to complete entry of the symbol. With practice, this can be a faster way of entering "infinity" than using the Palettes.

Table 3.5: Keyboard shortcuts in math mode through the escape key

<table>
<thead>
<tr>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>In math mode, we type infin.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>After hitting the escape key, a menu of completions appears.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>We pick the first alternative (either by hitting the return key or by operating the mouse to select the first option) and what we typed is replaced by the selection.</td>
</tr>
</tbody>
</table>

Greek symbols can be entered by typing the romanized name of the letter, followed by escape. For example, in math mode, typing omega followed by escape produces $\omega$. Typing Omega followed by escape produces $\Omega$ (the upper case version of the Greek letter).

A shortcut to entering the symbolic constant $e$ (the base of the natural logarithm) is to type e, then hit the escape key, then return.

You can see a summary to all of the conveniences Maple offers through Help → Quick Reference.

3.4 Other word processor features

Inspection of the worksheet toolbar reveals many more word processing features: line justification, bold face and italics, numbered items, colored letters or backgrounds, font sizes, and font types. The Insert operation on the Maple toolbar allows creation of Tables and Images (graphics files). Rudimentary drawings can be inserted through Insert → Canvas. We encourage you to explore and make use of the features on your own.
3.5 Troubleshooting word processing

A phenomenon that you may encounter is not being able to switch back to math mode from text mode, even after performing the operation that should do so (clicking on the Text button of the document toolbar, typing control-T, performing Insert $\rightarrow$ 2DMath, etc. This may be due to the worksheet losing track of where you are in the document. A "sure-fire" cure for switching modes is to position the cursor at the point where you want to enter math, then do Format $\rightarrow$ Create Document Block. A dashed box will appear at the location of the cursor, indicating that it is again in math mode.

Tools $\rightarrow$ Spellcheck (alternatively, the F7 key) will run a spelling check on the non-math part of your document.

### 3.6 Summary of Chapter 3 material

<table>
<thead>
<tr>
<th>Name</th>
<th>Menu operation</th>
<th>Key short cut</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Important word processing operations in a Maple worksheet</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switch entry to 2D Math mode</td>
<td>Insert $\rightarrow$ 2D Math</td>
<td>control-R (command-R on Mac)</td>
</tr>
<tr>
<td></td>
<td>Click on &quot;Math&quot; oval in menu bar just below names of worksheets.</td>
<td></td>
</tr>
<tr>
<td>Switch entry to Text mode</td>
<td>Insert $\rightarrow$ Text</td>
<td>control-T (command-T)</td>
</tr>
<tr>
<td></td>
<td>Click on &quot;Text&quot; oval in menu bar just below names of worksheets.</td>
<td></td>
</tr>
<tr>
<td>Use a keyboard shortcut in Math mode</td>
<td></td>
<td>Type the shortcut, then hit the escape key. For example, typing omega and then escape will turn the text into $\odot$. Typing e and then escape will allow you to turn the text into the symbolic constant $e$ without needing the Expression Palette.</td>
</tr>
</tbody>
</table>
4 Chapter 4 Assignment

4.1 Chapter Overview

We learn how to label results with symbolic names through the operation of "assign to a name", sometimes called assignment. This allows us to reuse the results in subsequent steps of a multi-step calculation without retyping it.

The keyboard operation := provides a keyboard shortcut for assignment. := will be used heavily in later work in programming as we shift from mouse/menu operation to textual specification of calculations.

4.2 Assignment: remembering results for future use

We can compute a result and label it with name. This action is called assignment. We can do this with the clickable menu by the action right-click (control-click on Macintosh) → assign to a name. A pop-up menu will appear asking us to fill in the name that we want to use.

Once we have assigned a result to a name, we can use the name, and Maple will use the assigned value.

A name can be any sequence of upper- or lower-case letters, digits and the underscore character _. It must start with a letter. Maple distinguishes between upper and lower case letters, so result and Result are considered different names.

In programming, the term variable is used interchangeably with name. Both refer to an identifier which the action of assignment associates with a computed result. Computer books often talk about "assigning the result to a variable" which means the same thing as "assigning the result to a name".

Table 4.1: Assignment

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sin(π/4) + 1</td>
<td>After computing a result, we assign it to the name trigResult by clicking on the result, selecting the menu item assign to a name and then typing in the name.</td>
</tr>
<tr>
<td>1/2 √2 + 1</td>
<td>(4.1)</td>
</tr>
<tr>
<td>trigResult</td>
<td></td>
</tr>
<tr>
<td>(trigResult + 1) · (trigResult − 1)</td>
<td>We can then use the name instead of repeatedly entering or copying expressions.</td>
</tr>
<tr>
<td>1/2 (1/2 √2 + 2) √2</td>
<td>(4.3)</td>
</tr>
<tr>
<td>at 5 digits</td>
<td></td>
</tr>
</tbody>
</table>

43
4.3 Assignment keyboard shortcut :=

The Maple operator := (colon immediately followed by an equals) also performs assignment.

The general form of the assignment operation when using the keyboard is

<table>
<thead>
<tr>
<th>Form</th>
<th>Examples</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>name := expression whose value will be</td>
<td>x := 5</td>
<td>Assigns the name x the value 5.</td>
</tr>
<tr>
<td>assigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>poly := ( z + \frac{5}{2} + \sin\left(\frac{\pi}{3}\right) )</td>
<td></td>
<td>Assigns the name poly the value consisting of ( \frac{5}{2} + \sin\left(\frac{\pi}{3}\right) ) + whatever the assigned value of ( z ) is. If no value has been assigned the name ( z ), then the result is the algebraic formula: ( z + \frac{5}{2} + \sin\left(\frac{\pi}{3}\right) ).</td>
</tr>
</tbody>
</table>

When you enter an expression in Math mode (even if it's just a name, without any arithmetic), you ask Maple to evaluate what you have entered. Maple also (before it does anything else) figures out the values assigned to names that appear in the expression. Then it does arithmetic, function calculation, and any other operations you've described in the expression.

If you use a name/variable in an expression, and it has no assigned value, then Maple uses the rule that the value of an name with no assigned value is just the name itself.

Table 4.2: Assignment

<table>
<thead>
<tr>
<th>Examples of assignment with :=</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>( p := x^2 + x + a \cdot x + 5 )</td>
<td>We assign the name ( p ) the value of the expression. Note that since ( x ) and ( a ) have not been assigned values, the results of evaluation just leaves them as symbols.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( x^2 + x + ax + 5 )</td>
<td>(4.5)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( p + 1 )</td>
<td>If we enter an expression containing ( p ), its value is plugged in for the calculation of the result.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( x^2 + x + ax + 6 )</td>
<td>(4.6)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>( x := 3 )</td>
<td>Here we assign the name ( x ) the value 3.</td>
</tr>
<tr>
<td></td>
<td>(4.7)</td>
</tr>
</tbody>
</table>
### Examples of assignment with :=

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>$3$</td>
<td>Commentary</td>
</tr>
</tbody>
</table>
| $p$ | If we now do a calculation with $p$, the value of $x$ is used because $p$'s value mentions $x$. There may be a chain of assignments that Maple must look at to evaluate an expression.  

We can solve the result 1.3.4 for $a$ by right clicking that expression. |
| $17 + 3a$ |   |
| $\rightarrow$ solve |   |
| $\{a = \frac{-17}{3}\}$ | (4.9) |
| $x := 4$ | We change the value of $x$ by assigning it a different value.  

When we do another calculation with $p$, the most recent assigned value of $x$ is used. |
| $4$ | (4.10) |
| $p$ |   |
| $25 + 4a$ | (4.11) |
| $\rightarrow$ solve |   |
| $\{a = \frac{-25}{4}\}$ | (4.12) |
| $y := x$ | This a way of assigning 4 -- the current value of $x$ to the name $y$. |
| $4$ | (4.13) |
| unassign('x') | We can undo the connection between $x$ and any value by unassigning $x$. This operation produces no output, so no label. We can barely tell that it has happened. The quote marks surrounding the $x$ -- 'x' are man- |
Examples of assignment with :=

<table>
<thead>
<tr>
<th>Equation</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x^2 + x + ax + 5$</td>
<td>((4.14)) datory, otherwise (x) would be replaced by its value and Maple would try to unassign the corresponding value rather than (x) itself. (p) still has a value, but since (x) no longer has a value, we are back to the original result.</td>
</tr>
<tr>
<td>(y)</td>
<td>((4.15)) We may have unassigned (x), but (y)'s unassigned value -- 4 -- is unaffected. The assignment just connects the name and the value determined when the assignment was performed (back at (4.13)). The information about which variables or expressions were used to figure out what the value was is not retained.</td>
</tr>
</tbody>
</table>

### 4.4 How to think about assignment: a mental model

The operation of assignment uses part of the computer's memory to remember the association of the name with the result. A useful mental model of assignment is to think of the computer creating a memory slot containing the result, labeled with the name being assigned to.

**Table 4.3: Mental model of assignment**

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(p := x^2 + x + ax + 5)</td>
<td>The mental model has a slot labeled (p) with the value (x^2 + x + ax + 5)</td>
</tr>
<tr>
<td>(x := 3)</td>
<td>If we then assign (x) a value, then there are two slots created. The second assignment only works on the slot associated with (x).</td>
</tr>
</tbody>
</table>
If we assign $p$ another value, then the memory slot associated with $p$ is cleared out and replaced with the new value. Note that the act of computing the new value for $p$ causes Maple to use any assigned values for $x$ that currently exist. This is different than with calculation (1.2.5). At that time, $x$ had no assigned value.

If we unassign a variable, then we can think of the slot as being deleted from the computer's memory. Unassigning $x$ does not unassign $p$ or change $p$'s assigned value.
4.5 The state of the Maple session and the look of the worksheet

When you first start up Maple with a blank worksheet, you haven't done any assignments. Thus it isn't surprising that a blank worksheet has no assigned variables. Using the mental model of the previous section, Maple has not allocated any memory to remember things -- no slots, no associations between results and names.

The state of a Maple session consists of all the variables that are currently assigned, and what their values are. The mental model of assignments is exactly the state of the session. The state changes every time we do another assignment or unassignment.

Only an assignment operation can change the state of the session. We know that we can jump back and execute a line in the worksheet a second time, just by positioning the cursor there and hitting enter (return). This raises the possibility that the way the worksheet looks is not an accurate reflection of the state of the session -- variables may have different values than what you'd think from reading the worksheet from top to bottom.

If you are not sure what the current value of a variable is, you can find out what it is by entering the name of the variable and hitting enter.

A saved worksheet does not save the state of the session (the variable assignments). Opening a saved worksheet file does not cause it to automatically execute the operations in the worksheet. This gives you a chance to edit the worksheet and possibly change the calculations specified, before carrying out the instructions.

Table 4.4: Example: The state of a Maple Session

<table>
<thead>
<tr>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>( p := x^2 + x + a\cdot x + 5 )</td>
<td>When we first load a worksheet, the state of the session is blank. For instance, we may see an equation like this in our worksheet, where it appears that the variable ( p ) stores the function ( x^2 + x + a\cdot x + 5 ). However, the variable ( p ) does not store anything yet!</td>
</tr>
<tr>
<td>( x^2 + x + ax + 5 )</td>
<td></td>
</tr>
<tr>
<td>( y := 2\cdot p )</td>
<td>This is evident if we immediately try to use the function ( p ) in another equation. Although we might expect ( y ) to equal ( 2\cdot x^2 + 2\cdot x + 2\cdot a\cdot x + 10 ), it actually equals ( 2\cdot p ). This is because we have just loaded the worksheet, and ( p ) is currently unassigned.</td>
</tr>
<tr>
<td>( 2p )</td>
<td></td>
</tr>
<tr>
<td>( p := x^2 + x + a\cdot x + 5 )</td>
<td>To make ( y ) equal to ( 2\cdot x^2 + 2\cdot x + 2\cdot a\cdot x + 10 ), we need to go back to the line where we assigned ( p ) and hit enter. Then we can go back to where we assigned ( y ) and hit enter to get the expected result.</td>
</tr>
<tr>
<td>( x^2 + x + ax + 5 )</td>
<td></td>
</tr>
<tr>
<td>( y := 2\cdot p )</td>
<td></td>
</tr>
<tr>
<td>( 2x^2 + 2x + 2ax + 10 )</td>
<td></td>
</tr>
</tbody>
</table>
4.6 restart causes all assignments to be forgotten

We've seen that it's possible to erase a particular assignment using unassign. If we want to forget all assignments we've made so far, then we can use restart. This can be useful in situations where you've done some work and made some assignments, but now want to switch to working on a different problem and would like Maple to forget about the assignments you made before. It is generally a good idea to restart at the beginning of unrelated sections just in case variables were previously assigned values that might not be related to their use in the new section.

Table 4.5: Evaluation of expressions involving assigned variables

<table>
<thead>
<tr>
<th>Examples of assignment with :=</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>$p := x^2 + x + a \cdot x + 5$</td>
<td>We were expecting p's value to be the expression $x^2 + x + a \cdot x + 5$. Evidently we must have done some assignment to x previous in the session that's &quot;contaminating&quot; this operation. If we had an accurate mental model of the state of session, it would have included an assignment of 5 to x. We would like to forget about that assignment and any others we've done previously in the session.</td>
</tr>
<tr>
<td>$35 + 5a$</td>
<td>(4.24)</td>
</tr>
<tr>
<td>restart</td>
<td>This has the effect of wiping out all assignments from the state of Maple session. The mental model has no assignments in it at this point.</td>
</tr>
<tr>
<td>$p := x^2 + x + a \cdot x + 5$</td>
<td>Now we have the desired result.</td>
</tr>
<tr>
<td>$x^2 + x + ax + 5$</td>
<td>(4.25)</td>
</tr>
</tbody>
</table>

4.7 Evaluation and assignment

Assignment really requires two steps. The first is figuring out the result. The second is assigning the result to the name. The "figuring out the result" step is called evaluation.

Evaluation in Maple proceeds in two phases. The first is to determine if any of the symbols in the expression being evaluated have an assigned value. If so, those values are used. If those values involve other symbols, those are in turn checked for values, etc..

Symbols without an assigned value have their own names as their value. This allows you to enter an expression such as $x^2 + 2 \cdot x + 5$ in x and use the x's as symbols in the normal mathematical style as long as you don't assign x a value.

Table 4.6: Evaluation of expressions involving assigned variables

<table>
<thead>
<tr>
<th>Examples of assignment with :=</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>restart</td>
<td>We start fresh through restart.</td>
</tr>
<tr>
<td>$p := x^2 + x + a \cdot x + 5$</td>
<td>We assign the name p the value of the expression. Since x and a have not been assigned values, the results of evaluation just leaves them as symbols. The mental model of the state of the Maple session just has one assignment.</td>
</tr>
<tr>
<td>$x^2 + x + ax + 5$</td>
<td>(4.26)</td>
</tr>
</tbody>
</table>
### Examples of assignment with :=

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x := 3$</td>
<td>If we assign $x$ a value, then evaluating $p$ causes its assigned value $x^2 + x + a \cdot x + 5$ to be evaluated.</td>
</tr>
<tr>
<td>$p$</td>
<td>$3$</td>
</tr>
<tr>
<td>$17 + 3a$</td>
<td></td>
</tr>
<tr>
<td>$x := 4$</td>
<td>If we change the assigned value of $x$ and evaluate $p$ again, this time 4 is used everywhere in the expression $x^2 + x + a \cdot x + 5$. At this point, the mental model of the state of the Maple session is</td>
</tr>
<tr>
<td>$p$</td>
<td>$4$</td>
</tr>
<tr>
<td>$25 + 4a$</td>
<td></td>
</tr>
<tr>
<td>$a := y$</td>
<td>Assigning a a value also changes the result of evaluating $p$. The assigned value of $p$ hasn't changed, but the result of evaluating $p$ takes into account that $a$ now has a value. After (1.7.8) the mental model of the state of the Maple session is:</td>
</tr>
<tr>
<td>$y$</td>
<td>$y$</td>
</tr>
<tr>
<td>$p$</td>
<td>$x^2 + x + a \cdot x + 5$</td>
</tr>
<tr>
<td>$25 + 4y$</td>
<td></td>
</tr>
<tr>
<td>$result2 := p$</td>
<td></td>
</tr>
</tbody>
</table>
### 4.8 Troubleshooting assignments

**Equations are not the same as assignment**

Assignment is an operation that many programming languages have. In some languages (e.g. Maple, Pascal, Eiffel) := is used for the assignment operation. In others (C, Java, Matlab) = is used as the symbol for assignment. Maple uses := because it uses = for equations. It would be confusing to computers and to human readers to use the same symbol for two common but different operations in a single language.

<table>
<thead>
<tr>
<th>Examples of assignment with :=</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>$25 + 4y$</td>
<td></td>
</tr>
</tbody>
</table>

$a := z + 1$

<table>
<thead>
<tr>
<th>$z + 1$</th>
<th>Changing the value of $a$ causes a different result when evaluating $p$ again, but doesn't change the result of evaluating result2. This is because result2 does not change with the assignment to a done in (4.34). Its value is still $25 + 4y$. The mental model of the state of the session after the operations (4.26) through (4.36) are done is</th>
</tr>
</thead>
</table>

$p$

<table>
<thead>
<tr>
<th>$29 + 4z$</th>
<th>(4.35)</th>
</tr>
</thead>
</table>

`result2`

<table>
<thead>
<tr>
<th>$25 + 4y$</th>
<th>(4.36)</th>
</tr>
</thead>
</table>

#### 4.8.4 and := mean different things in Maple

<table>
<thead>
<tr>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>$a := 3$</td>
<td>We assign a the value 3.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>$3$</th>
<th>(4.37)</th>
</tr>
</thead>
</table>

$x := 4$

<table>
<thead>
<tr>
<th>$x = 4$</th>
<th>This is an equation. It doesn't assign x any value.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>$x = 4$</th>
<th>(4.38)</th>
</tr>
</thead>
</table>
\[ p := a + x \]

We assign \( p \) the value of the expression \( a + x \). \( a \) stands for the value 3 at this point since we did an assignment to it. \( x \) is just a symbol that has no assigned value.

\[
3 + x \quad (4.39)
\]

\[ x := 47 \]

We can do an assignment to \( x \).

\[
47 \quad (4.40)
\]

\[ p := a + x \]

This time \( p \)'s value is \( 3 + 47 = 50 \).

\[
50 \quad (4.41)
\]

**The name to be assigned always goes on the left hand side of the :=**

Since \( 5 = x \) and \( x = 5 \) mean the same thing as mathematical equations, some people think that this should mean that \( x := 5 \) and \( 5 := x \) should both assign the value 5 to \( x \). However, only \( x := 5 \) does the assignment.

**Assignment := is not symmetric. It matters which side the name is on**

\[ 5 := x \]

Error, illegal use of an object as a name

This doesn't mean anything to Maple. The name is supposed to be on the left hand side.

\[ x := 5 \]

This assigns \( x \) the value 5.

\[
5 \quad (4.43)
\]

\[ z := y \]

This assigns \( z \) the (symbolic) value \( y \). It doesn't assign \( y \) any value.

\[
y \quad (4.44)
\]
To undo all assignments, use restart

Sometimes you want Maple to forget all the assignments you have made in a session. You can get this to happen either by using unassign on each assigned name, or by entering restart in Math mode and then hitting enter. This will unassign everything, undoing all the assignments.

restart does not erase the worksheet, however. The worksheet still looks the same, including the written record of the assignments you had previously done. What the restart does is to delete all the slots you have set up in your mental model.

A subsequent assignment to the same name/variable undoes the previous assignment

Every name/variable can be assigned at most one value at a time. It is permissible to assign a name several times during a sequence of operations, but each assignment replaces the previous association. While the document will record each assignment, only the most recently performed assignment will be in effect if you use a name after it is assigned.

Table 4.7: Reassignment undoes the effect of previous assignment

<table>
<thead>
<tr>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>$a := 3$</td>
<td>This example perform a series of assignments. Its purpose is to demonstrate the effect of reassignment and unassignment. First, we assign $a$ the value 3.</td>
</tr>
<tr>
<td>$x := 4 + a$</td>
<td>We assign $x$ the value that's 4 plus the value of $a$.</td>
</tr>
<tr>
<td>$a := 5$</td>
<td>We assign $a$ the value of the expression $a + x$. $a$ stands for the value 3 at this point since we did an assignment to it. $x$ is just a symbol that has no assigned value.</td>
</tr>
<tr>
<td>Example</td>
<td>Commentary</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$x$</td>
<td>If we ask for the value of $x$ we still get 7, which is what it was set to after the last assignment of $x$ at (1.8.7). Maple does not go back and come up with a new value of $x$ just because $a$ has been assigned subsequent to (1.8.7).</td>
</tr>
<tr>
<td></td>
<td>7 (4.50)</td>
</tr>
<tr>
<td>$y := x + a + 1 + z$</td>
<td>We can do an assignment to $y$. The expression $x + a + 1$ evaluates to the currently assigned value of $x$ which is 7, plus the most recently assigned value of $a$ which is 5, plus 1, plus the most recently assigned value of $z$. Since $z$ has no assigned value, it is treated as an algebra symbol and left as the symbol $z$.</td>
</tr>
<tr>
<td></td>
<td>$13 + z$ (4.51)</td>
</tr>
<tr>
<td>unassign('a')</td>
<td>If we unassign $a$, the previously assigned value is forgotten. But that does not cause the previously assigned values of $y$ and $x$ to be forgotten.</td>
</tr>
<tr>
<td>$a$</td>
<td>$a$ (4.52)</td>
</tr>
<tr>
<td>$y + 47$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>$60 + z$ (4.53)</td>
</tr>
<tr>
<td>$x$</td>
<td>7 (4.54)</td>
</tr>
</tbody>
</table>

Some names are already used by Maple. You will get an error message if you try to assign to them yourself.

When you first start up Maple, the names that you would ordinarily think of using to assign to are not assigned. However a few are, such as the symbolic constants Pi and I. Maple will tell you that such names are reserved for system use. You need to pick another name.

Table 4.8: Maple won’t let you use some names it is already using

<table>
<thead>
<tr>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pi := 47</td>
<td>You can't redefine a symbolic constant.</td>
</tr>
</tbody>
</table>
### Example

<table>
<thead>
<tr>
<th>Error, attempting to assign to ‘Pi’ which is protected</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>for := 3.1</th>
</tr>
</thead>
</table>

| Error, controlling variable of for loop must be a name |

| for := 3.1 |

<table>
<thead>
<tr>
<th>solve := x + 1</th>
</tr>
</thead>
</table>

| Error, attempting to assign to ‘solve’ which is protected |

| solve is the name of operation that solves equations. You can't change its meaning by using it as a variable to assign to. |

### 4.9 Summary of Chapter 4 material

#### Assignment

**General form**

Assignment is performed by using the **assign to a name** operation of the clickable menu.

<table>
<thead>
<tr>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>47</td>
</tr>
<tr>
<td>47</td>
</tr>
<tr>
<td>x</td>
</tr>
</tbody>
</table>

**Examples**

Assignment also be performed by typing in the name, followed by :=, followed by the expression whose value will be the result to be assigned.

<table>
<thead>
<tr>
<th>symbol name := expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>x := 5</td>
</tr>
<tr>
<td>y := z + ( \frac{x^2}{2} )</td>
</tr>
</tbody>
</table>
\[ z + \frac{25}{2} \]  

### Unassignment

<table>
<thead>
<tr>
<th>General form</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>unassign('symbol name')</code></td>
<td><code>x + 1</code></td>
</tr>
</tbody>
</table>

\[ 6 \quad (4.60) \]

\[ unassign('x') \]

\[ x + 1 \]

\[ x + 1 \quad (4.61) \]

**restart**

Undoes all assignments made by the user in the session so far.
5 Chapter 5 Building scripts

5.1 Chapter Overview

We briefly discuss a few extra concepts useful with solve: how to use a combination of relations rather than just a single equation, and how to take apart or combine by the various forms of solve.

We then explore the concept of script: a sequence of operations useful for solving a problem. We find that it's often the case that the need for a computation is driven by its reuse -- doing the same thing but with slight alterations each time. A frequently recurring scenario is a parameterized computation: 1) use variables to assign values to the parameters and 2) have subsequent steps of the computation refer to the parametric variables. Maple is well-equipped for reuse of parameterized scripts, since it has an operation Edit → Execute → Selection or Worksheet. This makes it easy to solve different versions of a problem by editing the parameter values and re-executing the script.

5.2 The structure of information in Maple: getting information from solve

The result of the solve operation can have multiple parts if there are multiple solutions to the equation. In this case, the result of solve is a sequence, list, or set of solutions, and we can select each part by giving an index (either 1 or 2).

\[
eq 1 s := 3 \cdot x = x^2 - 28 \quad 3x = x^2 - 28 \quad \text{solve} \quad \{x = -4\}, \{x = 7\} \quad \text{select entry 1} \quad \{x = -4\}
\]

\[
eq 1 s \quad 3x = x^2 - 28 \quad \text{solve} \quad \{x = -4\}, \{x = 7\} \quad \text{select entry 2} \quad \{x = 7\}
\]

If we give solve a linear equation, it has only one solution. We can still select the first entry.

\[
eq 2 s := 3 \cdot x = 28 \quad \text{solve} \quad \{x = 28/3\} \quad \text{select entry 1} \quad x = 28/3
\]

If we do "solve for x" for the same equation, we see that the answer comes back in a slightly different form. But it still has parts.

\[
eq 1 L = 3x = x^2 - 28 \quad \text{solve for x} \quad [[x = -4], [x = 7]] \quad \text{select entry 2} \quad [x = 7]
\]

Maple (as well as many other programming languages) can compute with objects that have structure. Here are four different kinds of structures that Maple can handle:

<table>
<thead>
<tr>
<th>Table 5.1: Basic data structures in Maple and operations to extract parts of them</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of structure</td>
</tr>
<tr>
<td>Equations, inequalities</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Type of structure</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td><strong>Square Roots</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Sequences</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Sets</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Lists</strong></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
For the time being, we just want you to recognize the different kinds of structures that are output by `solve` and other functions and be able to select parts from them. Later on we will get a lot of work done by performing more sophisticated operations with them.

### 5.3 Finding simultaneous solutions, constraining solutions.

Suppose we want to solve the system of equations $x + y = 5$ and $-3y + 7 = x$. This means finding values of $x$ and $y$ that simultaneous satisfy both equations. We can do this in Maple by typing in the first equation and then the second, separated by a comma. This is called entering a *sequence* of equations. Right-clicking (control-click on Macintosh) on the sequence will allow you to solve the system.

In Lab 1, you discovered that `solve` could also handle inequalities as well as equalities. You can enter a sequence of equations and inequalities to `solve`. This can be used to limit solutions to a particular range of values.

**Table 5.2: Solving simultaneous equations**

<table>
<thead>
<tr>
<th>Type of structure</th>
<th>What they look like</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$x + y = 5, -3y + 7 = x$</td>
<td>$x + y = 5, -3y + 7 = x$ (5.14)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>${x = 4, y = 1}$ (5.15)</td>
</tr>
<tr>
<td></td>
<td>$p := x^4 + 3x^2 - 57.5 = 0$</td>
<td>Solving this equation produces 4 roots. Two of them are complex numbers (since they have $i$ in them) the others are real.</td>
</tr>
</tbody>
</table>
5.4 Scripting: creating computational work in reusable form

Consider the problem you did in Lab 1, along with a solution:

**Version 1 and solution**


A breeding group of 20 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, $N$, after $t$ years will be given by the formula:

$$N = \frac{220}{1 + 10 \cdot (0.83)^t}$$

and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 80.

(a) Graph $N$ versus $t$.

(b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work.

(c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of $t$.)
Solution to (a)

\[ N = \frac{220}{1 + 10 \cdot (0.83)^t} \]

Once we have the sheep population, we need to play with the plotting ranges to see when the leveling off occurs. We'd have to think about it and experiment a bit -- but the computer makes the replotting easy to do once we make our decisions about what to try.

sheepPopExpr

\[ N = \frac{220}{1 + 10 \cdot 0.83^t} \]  \hspace{1cm} (5.22)

Solution to (b)

80 = sheepPopExpr
\[ 80 = \frac{220}{1 + 10 \cdot 0.83^t} \]  
\[ \text{solve} \]
\[ \{ t = 9.354227718 \} \]  
\[ (5.23) \]

**Solution to (c)**

We can read the leveling off point from the plot, assuming that we have figured out the appropriate time range in (b). Alternatively, we can do a little calculus and take the limit of the expression as \( t \) goes to infinity.

\[ \lim_{{t \to \infty}} \text{sheepPopExpr} \]

\[ 220. \]  
\[ (5.25) \]

We can imagine ourselves working as an environmental engineer for the National Forest Service and being very pleased with ourselves for solving the problem with Maple. But now we are handed two more wildlife management problems to do, from other regions in our territory:

**Version 2**

A breeding group of 33 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, \( N \), after \( t \) years will be given by the formula:

\[ N = \frac{330}{1 + 10 \cdot (0.79)^t} \]

and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 85.

(a) Graph \( N \) versus \( t \).
(b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work.
(c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of \( t \).)

**Version 3**

A breeding group of 45 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, \( N \), after \( t \) years will be given by the formula:

\[ N = \frac{450}{1 + 10 \cdot (0.63)^t} \]
and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 90.

(a) Graph $N$ versus $t$.
(b) How many years must the state of Montana maintain a program to care for the sheep? Show your work.
(c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of $t$.)

We have the feeling that we will shortly be handed problems for a number of other locations as well. How can we reuse our original work with minimal effort?

If we had the first solution, we could produce the second solution through copy-paste-edit-re-execute:

<table>
<thead>
<tr>
<th>Executing a clone of a script through copy-paste</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Copy and paste the original solution into a new document, or to a spot later in the same document. You do this as with a word processor -- select a region of the worksheet with the mouse, type control-C (command-C on a Mac). Then position the document cursor in the destination, and type control-V (command-V on a Mac). A duplicate of the solution should appear there.</td>
</tr>
<tr>
<td>2. Using the mouse, edit the formulae as needed. You only need to edit the black (input) formulae, not the blue ones.</td>
</tr>
<tr>
<td>3. Position the mouse at the first computation and hit enter. Continue to work your way through the sequence of the commands.</td>
</tr>
<tr>
<td>4. Alternatively, select the entire region containing the edited version of the solution and hit Edit-&gt;Execute-&gt;Selection.</td>
</tr>
<tr>
<td>5. If the region to be executed is the entire worksheet, then rather than selecting anything you can do Edit → Execute → Worksheet.</td>
</tr>
</tbody>
</table>

The results of executing the edited script are ???. It is not totally correct. We will have to change a few things by hand: the clickable operation "evaluate at a point" in step (b) will use $N=80$ (which is what the copy says) instead of $N=85$, so we will have to redo it. Also, the last plot will not show an appropriate vertical range unless we do that. We'd like to do a little less of this hand-tuning in re-execution. Also, we'd like to make it easier to remember what to change between multiple versions.

_A breeding group (page 65)._

### 5.5 Rewriting the script using assignment

While copying and editing is probably a little faster than typing in the whole script again, we can reduce the amount of hunting around for changes by writing a script finding the parameters of the problem, and writing the script so that it assigns values to the parameters at the beginning of the problem.

You may be doing assignments at several points in your calculation. Only the ones that would need to be changed between different versions of the problem define problem parameters. You may find the other ones very useful, but they don't have parameter status.

**Finding and naming parameters**

First, solve at least one version of the problem. Then, imagine what would need to be changed if you were trying to solve alternative versions of the problem. You can find parameters if you have several versions of a problem by looking at what changes in the worksheet from version to version.

For example, in the sheep problem, we note the following things changing in different versions of the problem. We pick names for these.

1. the numerator of the "sheep equation" ($P$)
2. the coefficient in the denominator of the equation ($c$)
3. the value of the stable population ($s$)

The other number in the script is the original population of the sheep. We realize that it can be derived by evaluating the "sheep equation" at $t=0$. Thus this value does not need to be a parameter as we can derive it from the other information. It might be a good check though.
We then write the script to assign values to the parameters at the start of the script, and then write the other operations and expressions in terms of the symbols.

This allows us to redo the script just by changing the values at the beginning of the script. We use the word processing features to add extra directions to make the script easier to use, basically saying "here, change these things", and "this is the end of where you should stop copying".

The result of executing the script is Version 2, with use of parameters (page 67).

Having created this script, we can handle the third version of the problem by editing the values of the parameters and executing the script again by selecting the entire script with the mouse, and then doing Edit->Execute->Selection. We get this result:

**5.6 Summary of script writing**

Script writing is appropriate when you expect to handle several different versions of the same problem. In professional work, this is often the case -- if it's worth doing at all, it's probably going to occur more than once.

*Figure out how to solve the problem first. Then write the script.* There's really not much point in writing the script if you don't have some idea of the sequence of operations in it.

Once you have a worksheet of instructions for solving one version of the problem, look at it and the other versions and find the parameters. Set up a new worksheet where the first thing you do is to assign values to the parameters. Then work through the rest of the instructions and rewrite them to use the parameters instead of the fixed values from one version of the problem.

**5.7 Troubleshooting scripts**

Programming books have the tendency to show things that work. They say less about what to do about the things that don't work. However, it is usually the case that computer users often spend more time "getting things to work" than "working". Learning how to get out of jams is at least as valuable as knowing how to enter operations and what they mean. We offer this advice, which is "commonsense about work" as applied to interactive software development:

1. Solve one version of the problem before you try to start scripting. You can use Maple to experiment -- enter and edit snippets of operations that try out the solution technique for part of the problem. Eventually edit them together so that they solve the whole problem. If you have only fuzzy notions about the math or the operations you want to proceed, your computer work will just amplify that. Having a worksheet that solves one version of the problem can remove a lot of the fuzziness.

   Where does the inspiration for solving the problem come from? If you are lucky, the solution may be told to you. Or you may find a description of a similar problem as a starter. But the big bucks, as they say, go to those who can devise the solution plan themselves.

2. Limit each step so that it is a small step. If you get into trouble, you will be able to nip it at the bud. This becomes a more prominent tactic in later work when we are tempted to construct long-winded one-line expressions that do everything at once.

3. Test pieces individually, then put them together. For example, if you don't really understand how to make a dotted line plot in teal with a title, you should try to do that with a simple plot (such as $x^2$) rather than an expression whose shape you aren't that familiar with it. Then take what works and substitute the real expression you want to plot in a copy of the $x^2$ plot operation.

   If you think about it, this is similar to what happened in Fall 2010 ENGR 101 Lab 2, where they first had you learn how to trigger an oscilloscope with the output of the function generator, rather than the output of the camera/flash sensor. The complexity of troubleshooting is reduced if you half as many unknowns to worry about. This can be called divide and conquer troubleshooting.

4. If what you have doesn't work, find something similar which does work, and then incrementally edit it. For example, if you
can't get $a := x^2 + 3 \cdot x + 1$ in, then first see whether you can get $a := 1$ to work. Once you succeed with that, edit the expression to $a := 3 \cdot x + 1$ and so forth.

5. If strange things continue to happen despite your best efforts to troubleshoot, it may be that previous settings in the Maple session are interfering with your current work. Recall that some people in the ENGR101 lab couldn't get their oscilloscopes to work because of settings changed in the oscilloscopes by groups earlier in the day. This can be particularly true if you are developing scripts and are assigning parameter values, then switch to development of another script in the same document. The values you assigned will not magically unassign themselves when you start working on something new in the same worksheet.

The remedy for this is to put a restart in as the first operation in your script, then re-execute the worksheet.

5.8 Attachments

Attachment: Version 2 of sheep script without parameters

Version 2 of sheep problem, with edited script

A breeding group of 30 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, $N$, after $t$ years will be given by the formula:

$$N = \frac{330}{1 + 10 \cdot (0.79)^t}$$

and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 85.

(a) Graph $N$ versus $t$.

(b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work.

(c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of $t$.)

Solution to (a)

$$N = \frac{330}{1 + 10 \cdot (0.79)^t} \quad \text{right hand side} \quad \frac{330}{1 + 10 \cdot 0.79^t} \quad \text{assign to a name} \quad \text{sheepPopExpr}$$

```
sheepPopExpr

\[
\frac{330}{1 + 10 \cdot 0.79^t}
\]
```

(5.27)
Solution to (b)

\[ 85 = \text{sheepPopExpr} \]

\[
85 = \frac{330}{1 + 100.79^t}
\]

\[ t = 5.277302835 \]

(5.29)

Solution to (c)

We can read the leveling off point from the plot, assuming that we have figured out the appropriate time range in (b). Alternatively, we can do a little calculus and take the limit of the expression as \( t \) goes to infinity.

\[
\lim_{t \to \infty} \text{sheepPopExpr}
\]

\[ 330. \]

(5.30)
Attachment: Version 2 of Sheep Script, with parameters

Version 2, with use of parameters

Start of parameters -- change these for each version of the problem

\[ P := 330 \]  

\[ 330 \]  

\[ c := 0.79 \]  

\[ 0.79 \]  

We call the size of the stable population \( s \).

\[ s := 85 \]  

\[ 85 \]  

End of parameters

(a) Graph \( N \) versus \( t \).

(b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work.

(c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of \( t \).)

\[ \text{sheepPopExpr} := \frac{P}{1 + 10^{- (c t)}} \]

\[ \frac{450}{1 + 10^{- 0.83 t}} \]  

Note that this sheepPopExpr is not a parameter since assignment is always the same for all versions of the problem.
To make the graphing work all the time, we set the vertical axis to "P+30" rather than a fixed value. This will set the vertical axis so that it will be 30 more than the value of P which from the first problem we have realized is the top of the graph.

\[ s = \text{sheepPopExpr} \]

\[ \frac{330}{1 + 10^{0.79^t}} \]  

\[ s = \frac{330}{1 + 10^{0.79^t}} \]  

\[ 85 = \frac{330}{1 + 10^{0.79^t}} \]  

solve
This is the time in years that model predicts it will take for the sheep population to reach self-sustaining status, allowing the wildlife managers to move onto another job.

(c) A little thinking reveals that the leveling off value (as indicated from the graph), is the numerator of sheepPopExpr, since the denominator goes to 1 as t goes to infinity.

$$\lim_{t \to \infty} \text{sheepPopExpr}$$

330. \hfill (5.37)

End of script

Attachment: Version 3 of Sheep Script, with parameters

Version 3 with edited parameters and re-execution

Start of parameters -- change these for each version of the problem

\( P := 450 \)

\[ 450 \] \hfill (5.38)

\( c := 0.83 \)

\[ 0.83 \] \hfill (5.39)

\( \text{sheepEquation} := N = \frac{P}{1 + 10^{-c}t} \)

\[ N = \frac{450}{1 + 10^{0.83t}} \] \hfill (5.40)

We call the size of the stable population \( s \).

\( s := 100 \)
End of parameters

(a) Graph $N$ versus $t$.
(b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work.
(c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of $t$.)

(a)

$$\text{sheepPopExpr} := \frac{P}{1 + 10^{-c} t}$$

(5.42)

Note that this sheepPopExpr is not a parameter since assignment is always the same for all versions of the problem.

To make the graphing work all the time, we set the vertical axis to "P+30" rather than a fixed value. This will set the vertical axis so that it will be 30 more than the value of P which from the first problem we have realized is the top of the graph.

$$\text{sheepPopExpr}$$

$$\frac{450}{1 + 10^{0.83t}}$$

(5.43)
\( s = \text{sheepPopExpr} \)

\[
100 = \frac{450}{1 + 10 \times 0.83^t} \quad (5.44)
\]

\( t = 5.634221548 \)

This is the time in years that model predicts it will take for the sheep population to reach self-sustaining status, allowing the wildlife managers to move onto another job.

(c) A little thinking reveals that the leveling off value (as indicated from the graph), is the numerator of \( \text{sheepPopExpr} \), since the denominator goes to 1 as \( t \) goes to infinity.

\[
\lim_{t \to \infty} \text{sheepPopExpr} = 450. \quad (5.45)
\]
End of script

### 5.9 Summary of Chapter 5 material

<table>
<thead>
<tr>
<th>Type of structure</th>
<th>What they look like</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic data structures in Maple</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Equations and inequalities</td>
<td>Expression related by $=, &gt;, &lt;, \geq, \leq, \neq$ or $\neq$.</td>
<td>$x + y = 0$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$x + y = 0$ (5.46)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$n^2 - 3\cdot n &gt; 4$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$4 &lt; n^2 - 3\cdot n$ (5.47)</td>
</tr>
<tr>
<td>Sequences</td>
<td>Values separated by a comma</td>
<td>19, 47, 92</td>
</tr>
<tr>
<td></td>
<td></td>
<td>19, 47, 92 (5.48)</td>
</tr>
<tr>
<td>Lists</td>
<td>A sequence surrounded by square brackets $[]$</td>
<td>$MyData := [1.0, x, \frac{3}{4}, a]$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$\left[ 1.0, x, \frac{3}{4}, a \right]$ (5.49)</td>
</tr>
<tr>
<td>Sets</td>
<td>A sequence surrounded by curly braces ${}$</td>
<td>$Scores := {3, 7, 3, 10}$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>${3, 7, 10}$ (5.50)</td>
</tr>
<tr>
<td>Solving simultaneous equations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$x + y = 5, -3\cdot y + 7 = x$</td>
<td></td>
<td>$x + y = 5, -3\cdot y + 7 = x$ (5.51)</td>
</tr>
</tbody>
</table>

The result of this `solve` is a set of solutions.
\[
\text{solve}
\]
\[
\{x = 4, y = 1\}
\]  
(5.52)

\[
p := x^4 + 3x^2 - 57.5 = 0
\]
Solving this equation produces 4 roots. Two of them are complex numbers (since they have 1 in them) the others are real.

\[
\text{solve}
\]
\[
x^4 + 3x^2 - 57.5 = 0
\]  
(5.53)

\[
\{x = 3.0380606341\}, \{x = -3.0380606341\}, \{x = 2.495959218\}, \{x = -2.495959218\}
\]  
(5.54)

\[
p, x \geq 0
\]
This gets the solver to list only the positive real solutions. We might be interested in only non-negative real solutions, if, for example, we were using the equation to model a physical situation and \(x\) was measuring weight. In this case the other values of \(x\) wouldn't be relevant to our situation.

\[
\text{solve}
\]
\[
x^3 + 3x^2 - 57.5 = 0, 0 \leq x
\]  
(5.55)

\[
\{x = 2.495959218\}
\]  
(5.56)

\[
\text{select entry 1}
\]
\[
x = 2.495959218
\]  
(5.57)

**Scripts**

<table>
<thead>
<tr>
<th>Creating a script for a problem</th>
<th>In a Maple worksheet, take a version of a problem and create a sequence of operations in the worksheet that solve it. Note similarities and differences between different versions of the problem. Envision what you'd have to change in the worksheet in order to solve a different version of the problem, and what would stay the same. You may have to rewrite some of the expressions to refer to the parameter rather than the value.</th>
</tr>
</thead>
</table>
Assign the parameters at the beginning of the script. Rework the rest of the script so that the formulas refer to the parameters by name, rather than the values used in the original version of the problem.

For example, if the value 42 appears in several places in your script, define a parameter \( p := 42 \) at the start of the script and edit the other occurrences of 42 to be \( p \) instead. When you have a different version of the problem, you can edit just the single line \( p := 42 \) into say \( p := 47 \) and won't need to edit any other lines of the script.

<table>
<thead>
<tr>
<th>Using a script</th>
<th>Copy and paste the script to a new location</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Edit the assignments to reflect the new version of the problem.</td>
</tr>
<tr>
<td></td>
<td>Edit-&gt;Execute-&gt;Selection, or just hit enter (return on Macintosh) multiple times to perform the operations in the new version of the script.</td>
</tr>
<tr>
<td>Rationale for using scripts</td>
<td>More work to do than clickable interface the first time. Saves time if you expect to want to reuse the operations on multiple versions of the same problem. Also it is less error prone.</td>
</tr>
</tbody>
</table>
Index

Symbols
! (exclamation point factorial), 14
(, 12
), 12
~ (minus or dash), 13
:=, 44
= (equation), 24
\317/200
   symbolic constant, 32, 33
\317/200 (symbolic constant), 29
^ (caret), 13
_ (underscore), 43
A
absolute error, 82
addition (+), 12
approximation error, 82
arc cosine, 29
arc sine, 29
arc tangent, 29
arithmetic, 11
   approximate, 29
   exact, 15
   operations, 11
assignment, 25
   mental model of, 46
asterisk, 12
autosaving, 23
Axiom, 5
B
backspace key, 19
backups
   retrieving, 23
base of natural logarithm (e), 32
brackets, 58
C
C (programming language), 51
C (the programming language), 5, 7
C++ (the programming language), 5
Canvas (Maple word processor feature), 40
caret (power), 13
circle-X, 9
Colorado, 60
comma, 58
command-=, 39
command-C (copy operation), 19, 63
command-R, 38, 39
command-T, 38
command-V (paste operation), 19, 63
command-X (cut operation), 19
computing
   algebraic, 1
   graphical, 1
   high performance, 3
   logical, 1
   numerical, 1
constant
   symbolic, 54
control-\, 39
control-C (copy operation), 19, 63
control-click, 24
control-R, 38, 39
control-T, 38, 39
control-V (paste operation), 19, 63
control-X (cut operation), 19
copy (editing operation), 19
copy and paste, 63
crash
   Maple, 23
curly braces, 58
cut (editing operation), 19
D
dashed rectangle, 10
delimiters in Maple: ( ) [ ] { }, 17
digits, 30
divide and conquer, 64
division (/), 12
documentation
   need for, 1
dot
   centered, 14
E
e, 40
   from keyboard not a symbolic constant, 32
   symbolic constant, 32, 33
e (natural logarithm), 29
Edit \342\206\222Execute\342\206\222Worksheet., 63
Edit->Execute->Selection, 63
ENGR101, 64, 65
tenet, 63
equation, 24, 57
error
   invalid fraction, 18
   invalid matrix/vector product, 17
   invalid sequence, 18
   invalid sum/difference, 16
   large, 84
large approximation, 85
logic, 22
missing operation, 16
numeric exception: division by zero, 17
relative, 82
unable to match delimiters, 17, 18
vocabulary, 21
Error
  attempting to assign to 'solve' which is protected, 55
controlling variable of for loop must be a name, 55
error message, 16
error
  absolute, 82
escape key, 40
evaluate
  at a point, 63
evaluating state, 23
evaluation, 44
  of expressions, 11
exponentiation, 20
expressions
  algebraic, 24
  from palette, 28
F
factorial (!), 14
fence post error, 31
find something similar, 64
Format -> Create Document Block, 41
Fortran, 5
fuzzy notions, 64
G
gigaflop, 3
graphical user interface (GUI), 5
H
help
  quick, 9
Help (Maple menu), 40
I
I (square root of -1), 54
Image (Maple word processor feature), 40
index, 57
inequalities, 57
infin (shortcut for infinity in math mode), 40
Insert (Maple menu item), 40
Insert->2-D Math, 38
Insert->Text, 38
interactive, 5
inverse trig functions, 29
J
Java, 5, 51
L
label, 11
left arrow key, 19
left hand side, 57
left hand side (right-click menu), 30, 34
linear algebra, 17
list, 58
logarithm
  base e, 29
logic error, 22, 31
Los Alamos National Laboratory, 3
M
Macsyma, 5
Maple, 5
  as a word processor, 37
  document mode, 9
  math entry mode, 37
Mathematica, 5, 6
mathematical model, 1
Matlab, 5, 51
  Symbolic Toolkit, 6
maxdigits, 21
mental model, 46
minus, 12
mistake
  typographical
    how to fix, 19
multiple systems, 7
multiplication (*), 12
N
name
  assignment to, 43
National Forest Service, 62
negation (-), 13
numerical analyst, 85
O
Oak Ridge National Laboratory, 3
Octave, 5
omega (Greek letter), 40
Omega (upper case Greek letter), 40
oscilloscope, 64, 65
P
palette, 28
square root, 28
palettes, 40
parameter, 63
parentheses, 12
paste (editing operation), 19
petaflop, 3
Pi, 54
Pi (symbolic constant), 54
pick names, 63
PlotBuilder, 27
plotting, 26
plus, 12
power (^), 13
Python, 5, 6

Q
Quick Reference (help menu item), 40

R
ready
Maple, 23
rectangle
dashed (entry), 10
relative error, 82
restart, 53, 65
retrieving
a Maple session, 22
reuse
of software, 1
right hand side, 57
right hand side (of equation), 30
right hand side (right-click menu), 30, 34
right-click, 24

S
SAGE, 5
Saving
a Maple document, 22
scripting, 61
select
tentry, 57
item from a set, 30
select entry (right-click menu), 31, 34
sequence, 18, 58
set, 58
empty, 72
sheep, 60
shortcuts
keyboard, 40
Show All Palettes, 40
simulation, 1
slash, 12
small steps, 64

solve, 57
by right-clicking or control-clicking, 24
numerical, 30
square root
from palette, 28
state display
of Maple, 23
state of a Maple session, 48
subscript, 39
subtraction (-), 12
supercomputer, 3

T
Table (Maple word processor feature), 40
teraflop, 3
test, 64
text entry mode, 38
text mode to math mode
can't switch back, 41
Tools->Spellcheck, 41
troubleshooting, 64
assignment, 53
word processing, 41

U
unassign, 45, 47, 53
underscore, 39
underscore (_), 43

V
value
of an unassigned name, 44
variable
programming, 43
View (Maple menu), 40
visualization, 1

W
We assign p the value of the expression a + x. a stands for the
value 3 at this point since we did an assignment to it. x is just a
symbol that has no assigned value., 55
what you see is what you get, 37
WYSIWYG, 37